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Περίληψη 
 

      Στην εργασία αυτή περιλαμβάνονται διάφορες ασκήσεις οι οποίες έγιναν με βάση την ύλη που 

διδάσκεται στο μάθημα "Σχεδίαση VLSI κυκλωμάτων για τηλεπικοινωνιακές εφαρμογές" από τον 

Δρ. Σωτήριο Ματακιά. Να τονίσω ότι όλα τα κυκλώματα που σχεδιάστηκαν και αναλύθηκαν 

αποτελούνταν από Lumped Elements (αντιστάσεις, πυκνωτές και πηνία) και όχι από Distributed 

Elements (γραμμές μεταφοράς κτλ).  

    Αρκετές από τις ορολογίες είναι γραμμένες σκόπιμα στα αγγλικά ώστε να είναι πιο εύκολο για 

τον χρήστη που ενδιαφέρεται, να ψάξει παραπάνω πληροφορίες στο διαδίκτυο για αυτά. H 

εργασία αυτή έχει στόχο να παρουσιαστούν οι βασικές τεχνικές σχεδίασης κυκλωμάτων που 

προσφέρει το ADS.  

    Συγκεκριμένα στο 1ο κεφάλαιο της εργασίας γίνεται μια αναφορά στα χαμηλοπερατά φίλτρα και 

πως μπορούμε να συγκρίνουμε τις χαρακτηριστικές αποκρίσεις δύο φίλτρων στο ίδιο γράφημα. 

Επίσης παρουσιάζεται η τεχνική του tuning. Στο 2ο κεφάλαιο μαθαίνουμε πως γίνεται μεταφορά 

ενός από τα πολλά παραδείγματα που περιέχει το ADS, μέσα στο directory που έχουμε 

δημιουργήσει το δικό μας project.  

 

      Στο 3ο κεφάλαιο παρουσιάζονται τα κυκλώματα RLC. Σχεδιάζουμε ένα τέτοιο κύκλωμα και 

μαθαίνουμε πως τοποθετούμε αρκετά στοιχεία μέσα σε ένα "κουτί" με δύο ακροδέκτες (εισόδου-

εξόδου). Το κεφάλαιο αυτό κλείνει με μία εφαρμογή επιλογής ενός συγκεκριμένου ραδιοφωνικού 

σταθμού και απόρριψης κάποιων άλλων.  

 

       Στο 4ο κεφάλαιο παρουσιάζεται η τεχνική του Sweep μεταβλητών και πως υπολογίζουμε το 

σημείο συμπίεσης ενός ενισχυτή στο ADS. Το 5ο κεφάλαιο αποτελεί την συνέχεια του τέταρτου 

κεφαλαίου και αναφέρεται στο υπολογισμό των προϊόντων ενδοδιαμόρφωσης στην έξοδο ενός 

ενισχυτή. Παρουσιάζεται η διαδικασία για αυτό.  

 

      Στο 6ο κεφάλαιο γίνεται αναφορά στα κυκλώματα προσαρμογής και συγκεκριμένα στα 

δικτυώματα L. Με χρήση του χάρτη Smith στο περιβάλλον ADS παρουσιάζεται η δουλειά αυτή. Στο 

7ο κεφάλαιο παρουσιάζεται ένα πραγματικό πρόβλημα προσαρμογής στις θύρες εισόδου και 

εξόδου ενός ενισχυτή. Ο τρόπος κατασκευής δικτυώματος προσαρμογής μπορεί να βασιστεί στην 

χρήση του χάρτη Smith ή σε μια τεχνικής βελτιστοποίησης αφού βάλουμε πρώτα κάποιους 

στόχους. 

 

Τέλος στο 80 και τελευταίο κεφάλαιο παρουσιάζεται η σχεδίαση ενός ενισχυτή με χρήση ενός BJT. 

Η άσκηση ξεκινάει με την δημιουργία του BJT και των χαρακτηριστικών του, στην συνέχεια 

δημιουργείται ένα κύκλωμα πόλωσης και έπειτα εισάγονται τα κατάλληλα στοιχεία ώστε να 

μπορεί να λειτουργήσει σωστά ως ενισχυτής. Γίνεται έλεγχος της συμπεριφοράς του ενισχυτή και 

παρουσιάζεται η σημαντικότητα της τροφοδοσίας στην λειτουργία του. 
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Εισαγωγή στο ADS 
 

 

Ι. Ανοίγουμε το πρόγραμμα ADS2009 και εμφανίζεται ένα παράθυρο «Getting Started 

with ADS» . Για την ώρα κλείνουμε το παράθυρο αυτό. Αν δεν εμφανιστεί σημαίνει ότι 

υπάρχει προεπιλογή, μη εμφάνισης του. 

 

 

ΙΙ. Το κυρίως παράθυρο (Main_Window) αποτελείται από την παρακάτω εικόνα. Κάποια 

από τα directories δεν θα συμπεριλαμβάνονται στον δικό σας υπολογιστή, αφού δεν θα 

τα έχετε δημιουργήσει. 

 

ΙΙΙ. Για αρχή θα πρέπει να δημιουργήσουμε ένα καινούργιο project. Για να γίνει αυτό 

πηγαίνουμε: 

File>New Project  ή χρησιμοποιούμαι το εικονίδιο όπως φαίνεται παραπάνω! Ένα 

καινούργιο παράθυρο ανοίγει στο οποίο πρέπει να δηλώσουμε το όνομα του project. 

Εισάγουμε lab_AM , όπου ΑΜ= ο αριθμός μητρώου μας, στην περίπτωση αυτή έβαλα τον 

Νew Schematic Window 

Create a New Project 
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δικό μου 2011117. Ως μονάδες επιλέγουμε χιλιοστά (mm-millimeter). Ως προεπιλογή θα 

έχει mil. 

 

Aφού πατήσουμε ΟΚ, ανοίγει ένα παράθυρο Schematic. 

 

 

 

 

ΙV. Πηγαίνοντας στο Main_Window, και πατώντας το File view , παρατηρούμαι ότι έχει 

ανοίξει ένας φάκελος με το όνομα του project που επιλέξαμε lab_2011117. Επίσης έχουν 

δημιουργηθεί και directories (data, networks κτλ) αυτόματα και αυτό σημαίνει ότι το 

λογισμικό είναι πλέον έτοιμο για την εισαγωγή των δεδομένων από τον χρήστη. 

Θα πρέπει να κάνουμε 

"save as" το Schematic να 

δηλώσουμε όνομα 

Το Schematic που 

δημιουργήθηκε, 

ανήκει 

στο lab_AM project 
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V.  Στην συνέχεια θα πρέπει να δώσουμε ένα 

όνομα στο Schematic, αφού για την ώρα 

είναι untitled. Συνεπώς, πηγαίνουμε στο 

παράθυρο του  Schematic και πατάμε: 

File>Save_Design as και δίνουμε το όνομα 

ως:Laboratory_1_LPF. Παρατηρούμε ότι θα 

αποθηκευτεί στο network_directory ως 

αρχείο με την κατάληξη .dsn 

υποδηλώνοντας ότι ένα αρχείο Design 

περιέχει πληροφορίες για το Schematic κ.α. 

 

Πηγαίνοντας ξανά στο Main_Window, και πατώντας το Project_View βλέπουμε ότι υπάρχει 

το αρχείο Laboratory_1_LPF.dsn που μόλις δημιουργήσαμε. 

 

 

Αν θέλαμε στο ίδιο project, να έχουμε και ένα δεύτερο Schematic για παράδειγμα ενός 

μίκτη, αυτό που θα κάναμε είναι: πηγαίνοντας στο Main_Window θα πατούσαμε, New 

Schematic Window και ξανά την διαδικασία File>Save_Design as, με όνομα 

Laboratory_1_mixer.dsn. Συνεπώς πηγαίνοντας στο Project_View θα είχαμε την εξής 

εικόνα: 

 

 

 

Eίμαστε τώρα έτοιμοι να σχεδιάσουμε το πρώτο μας σχηματικό! 
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Μέρος 1. Σχεδιασμός ενός χαμηλοπερατού φίλτρου 

 

   Εισαγωγή 

 

 Στο πρώτο μέρος της εργασίας θα κάνουμε μία ανάλυση και σχεδιασμό για φίλτρα. Γενικά 

υπάρχουν δύο κατηγορίες φίλτρων: 

1. Παθητικά φίλτρα που αποτελούνται από αντιστάσεις, πυκνωτές και πηνία. 

2. Ενεργά φίλτρα που κάνουν χρήση τελεστικών ενισχυτών. 

 Εδώ θα ασχοληθούμε με την πρώτη κατηγορία. 

 Τα παθητικά φίλτρα κατανέμονται σε δύο μεγάλες ομάδες: 

 

 Φίλτρα με χρήση αντιστάσεων και πυκνωτών (RC Filters). Είναι φτηνά σε κόστος 

και εύκολα να κατασκευαστούν. 

 Φίλτρα με χρήση πηνίων και πυκνωτών (LC Filters.) Έχουν καλύτερες αποδόσεις, 

αλλά είναι δύσκολο να βρεις τις ακριβής τιμές κυρίως για τα πηνία. Ένα από τα 

πλεονεκτήματα τους είναι ότι αποφεύγεται η χρήση αντιστάσεων (όπως στα RC 

φίλτρα) καθώς υπάρχει κατανάλωση ενέργειας σε αυτές (Power Dissipation). 

Ωστόσο όσο η συχνότητα αυξάνεται δημιουργούνται έντονα μαγνητικά πεδία και 

χρειάζονται μόνωση. Επίσης όσο φτάνουμε σε υψηλότερες συχνότητες, ειδικά τα 

πηνία εμφανίζουν μεγάλες τιμές αντίστασης αφού Zinductor=jωL (Ω). 

 

 

 

  Η κατηγορία με τα LC φίλτρα με την οποία θα ασχοληθούμε 

αποτελείται από δύο δικτυώματα: Pi-Section και T-Section φίλτρα. 

Ανάλογα με την εφαρμογή κάθε φορά γίνεται η ανάλογη χρήση 

κατάλληλου δικτυώματος. Οι ονομασίες αυτές υποδηλώνουν το 

σχήμα των ελληνικών γραμμάτων "π" και "τ". 

 

 Εμείς θα σχεδιάσουμε το Pi δικτύωμα  
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    Τα χαρακτηριστικά της συχνοτικής 

απόκρισης (Frequency response)  ενός 

φίλτρου φαίνονται στο διπλανό σχήμα. 

Μεταξύ των συχνοτήτων    f2-f1=BW είναι η 

περιοχή διέλευσης του φίλτρου. Οι 

συχνότητες που ανήκουν εκεί υφίστανται 

μηδενικές ή το μέγιστο 1-2dB απώλειες 

(Insertion Loss), ενώ αυτές που βρίσκονται 

εκτός της ζώνης αυτής ανήκουν στην 

περιοχή αποκοπής (stopband) και 

υφίστανται την ανάλογη  με την 

αρχιτεκτονική του φίλτρου εξασθένιση.1  

 

   Επίσης ανάλογα με την συχνοτική 

απόκριση ενός φίλτρου υπάρχουν 

τέσσερις μεγάλες κατηγορίες φίλτρων: 

A. Bessel Filters 

B. Butterworth Filters 

C. Elliptic Filters 

D. Chebyshev Filters 

 

   Κάθε μία από τις κατηγορίες φίλτρων έχει τα δικά του χαρακτηριστικά και 

χρησιμοποιείται ανάλογα με την εφαρμογή που θέλουμε να χρησιμοποιήσουμε. Τα φίλτρα 

που παρέχουν την πιο επίπεδη απόκριση στην ζώνη διέλευσης τους χωρίς κυματώσεις 

είναι τα φίλτρα Butterworth. Θα ασχοληθούμε σε λίγο με την σχεδίαση ενός τέτοιου 

φίλτρου με χρήση του ADS. 

 

 Στην πρώτη εργασία θα κατασκευάσουμε ένα χαμηλοπερατό φίλτρο με συχνότητα 

αποκοπής 2 GHz με χρήση πηνίων και πυκνωτών. Η αρχιτεκτονική που 

χρησιμοποιούμε είναι τυχαία απλά ικανοποιεί την συνθήκη ότι στην συχνότητα 

αποκοπής έχω -3 dB στην απόκριση του φίλτρου. Στην συνέχεια με χρήση κάποιων 

πινάκων και με συγκεκριμένη ανάλυση, σχεδιάζουμε ένα φίλτρο Butterworth. 

Γίνεται σύγκριση μεταξύ των δύο φίλτρων ενώ παράλληλα παρουσιάζεται η 

τεχνική του tuning. 

                                                        
1 Υπάρχει και η ζώνη μετάβασης (transition band) αλλά θα αποφύγουμε να μπούμε σε λεπτομέρειες. 
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1.1 Σχεδιασμός ζωνοπερατού φίλτρου 
 

   Επανερχόμαστε στο παράθυρο του Schematic. Εκεί που αναγράφεται Lumped-

Component είναι μία από τις πολλές παλέτες (Palette) τις οποίες έχει το ADS ώστε να 

οργανώνει τα εξαρτήματα που συμπεριλαμβάνει. 

 

 

   Πηγαίνοντας στην παλέτα Lumped-Components, επιλέγουμε τα στοιχεία που 

χρειαζόμαστε για την διάταξη μας αρχίζοντας με έναν πυκνωτή, C (προσοχή όχι το 

C_model).  Αφού επιλέξουμε τον πυκνωτή τον τοποθετούμε μέσα στο περιβάλλον εργασίας 

και στη συνέχεια πατάμε Esc για να αποδεσμεύσουμε τον κέρσορα.  

   Αν θέλουμε να περιστρέψουμε το στοιχείο που επιλέξαμε πατάμε CTRL και R (rotate) ή 

από το Schematic το αντίστοιχο εικονίδιο.  

    Στη συνέχεια τοποθετούμε και δεύτερο πυκνωτή C. Δεν χρειάζεται να πηγαίνουμε πάλι 

στην παλέτα, αφού μπορούμε να χρησιμοποιήσουμε το ιστορικό των στοιχείων 

(συγκεκριμένα αποθηκεύει τα 10 τελευταία). Επίσης τοποθετούμε και ένα πηνίο L.                

Η εικόνα που πρέπει να έχουμε είναι η εξής: 

Component 

History 

Component 

Palette 

Η 

επιλεγμένη  

palette 
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   Στη συνέχεια θα πρέπει να συνδέσουμε με καλώδιο τα στοιχεία μεταξύ τους. Επίσης 

πρέπει να μπούνε γειώσεις στα κάτω άκρα των πυκνωτών.  Τα εικονίδια στα δεξιά  είναι 

για τη διασύνδεση των στοιχείων και της γείωσης, αντίστοιχα. 

 

   Ο πυκνωτής C1 πρέπει να έχει τιμή 1 pF ενώ το πυκνωτής C2 πρέπει να έχει τιμή 3 pF. 

    Για να αλλάξουμε την τιμή του δεύτερου, κάνουμε διπλό κλικ πάνω στο στοιχείο, 

βάζουμε την τιμή που θέλουμε στο πρώτο πεδίο παραμέτρων και στην συνέχεια πατάμε 

Apply και ΟΚ. Για να δηλώσουμε τιμή μπορούμε και πάνω στο σχηματικό να 

κάνουμε κλικ στην τιμή του στοιχείου που θέλουμε και να γράψουμε κανονικά με 

το πληκτρολόγιο. Δοκιμάστε το είναι βολικό! 

   

   Ενώ κάνουμε την διαδικασία αυτή πατάμε File>Save_Design ή απλά πατάμε  το 

εικονίδιο αυτό, για να αποθηκεύουμε την εργασία μας. 

 

    Στην συνέχεια εισάγουμε από την παλέτα Simulation-S_Param, τον προσομοιωτή 

(Simulator) με αυτό το εικονίδιο .  Επειδή ο στόχος μας είναι να υπολογίσουμε την       

S-Parameter2, S21, θα πρέπει να τοποθετηθούν θύρες εισόδου και εξόδου στο φίλτρο 

μας.  

   Ως θύρα εισόδου και εξόδου θα τοποθετήσω τερματισμούς (term)  . Βρίσκονται στην 

ίδια παλέτα με τον προσομοιωτή των S-Parameters και πρέπει να προσέξουμε να 

τοποθετηθεί μία γείωση στο ελεύθερο άκρο της κάθε θύρας. Τελικά το σχηματικό 

πρέπει να είναι κάπως έτσι: 

 

 

                                                        
2 Θα ασχοληθούμε αρκετά με την μελέτη των S-Parameters στο βοήθημα αυτό. 
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Στην συνέχεια πρέπει να κάνουμε Setup τον Simulator.  

Πατάμε διπλό-κλικ πάνω του και στο παράθυρο που 

εμφανίζεται επιλέγουμε την περιοχή συχνοτήτων που θα 

σαρώσουμε και πιο θα είναι το βήμα (step-size) για αυτό.  

 

Δηλώνουμε Start 0 GHz. Για να έχουμε καλύτερη ανάλυση 

δηλώνουμε ως βήμα 0.1 GHz. Στην συνέχεια πηγαίνουμε στο 

Display tab. Οι επιλογές που εμφανίζονται μας επιτρέπουν να  

κρίνουμε ποιες θα είναι οι παράμετροι του Simulator που 

θέλουμε να εμφανίζονται στο παράθυρο του Schematic και 

ποιες όχι.  Από default υπάρχουν το Start, Stop, Step. To 

αφήνουμε όπως έχει. Επίσης στο Parameters tab μπορούμε να 

επιλέξουμε αν θέλουμε τον υπολογισμό των S, Y, Z παραμέτρων. 

  

 Περισσότερες πληροφορίες για τις διάφορες 

παραμέτρους θα βρείτε στις διαφάνειες του 

κ.Ματακιά/μάθημα 10ο 

 

  Αφήνουμε όπως έχει τον υπολογισμό των S-Parameters. Πατάμε Apply και στην συνέχεια 

ΟΚ. Είμαστε έτοιμοι να προσομοιώσουμε το κύκλωμα που μόλις σχεδιάσαμε. 

 

 

 Για να τρέξουμε την προσομοίωση πατάμε το εικονίδιο  ή από το  πληκτρολόγιο 

το F7. 

 

 

  Ένα παράθυρο  θα εμφανιστεί στο οποίο 

υπάρχουν κάποια σχόλια για την προσομοίωση που 

κάναμε. Αν δεν υπάρχει κάποιο πρόβλημα στο 

κύκλωμα το παράθυρο Simulation/Synthesis 

Messages θα είναι κενό. 

 

 

 

 

 

 



Εθνικό και Καποδιστριακό 

Πανεπιστήμιο Αθηνών 

                         Σχεδίαση VLSI κυκλωμάτων για τηλεπικοινωνιακές εφαρμογές                       (2014-15) 

 

 

13 

  Αν για παράδειγμα αμελήσουμε να βάλουμε γείωση στην θύρα εξόδου, αφού πατούσαμε  

F7, θα εμφανιζόταν το εξής μήνυμα: 

 
 

 

 

    Ελπίζουμε να μην μας εμφανίσει κάποιο 

λάθος και συνεχίζουμε. Ένα παράθυρο 

data_display θα εμφανιστεί με αρκετές 

επιλογές.  

  Το όνομα του παραθύρου είναι το όνομα που 

δώσαμε στο Schematic προηγουμένως 

Laboratory_1_LPF. 

 

 

     

 

Το ΑDS μας δίνει τη δυνατότητα να δούμε τα αποτελέσματα της προσομοίωσης με 

διάφορους τρόπους. Πηγαίνουμε στην παλέτα αριστερά και πατάμε το Rectangular Plot 

ώστε να δημιουργήσουμε το γράφημα S21.(μπορούμε να πάρουμε πληροφορίες πατώντας 

τον χάρτη Smith, δοκιμάστε το). 

Πατάμε διπλό-κλικ στην επιλογή S(2,1) και ανοίγει ένα καινούργιο παράθυρο. Πατάμε dB 

και ΟΚ.  

Εισαγωγή Πίνακα 

Εισαγωγή εξίσωσης  

Χάρτης Smith 

Rectangular Plot 

Επιλογές για τον marker 

Πολικές Συντεταγμένες 
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Η γραφική παράσταση που θα εμφανιστεί θα πρέπει να είναι η απόκριση (response) ενός 

χαμηλοπερατού φίλτρου με την εξής μορφή: 

 

 

   Επίσης από τις επιλογές για marker επιλέγουμε την 

πρώτη επιλογή   και τον τοποθετούμε πάνω στο 

γράφημα. Αν πατήσουμε πάνω στον πίνακα με τις 

πληροφορίες για τη συχνότητα και τα dB ή στον marker 

που είναι πάνω στη γραφική, μπορούμε με τη χρήση του 

πληκτρολογίου να μετακινήσουμε δεξιά ή αριστερά και 

να δούμε τις αντίστοιχες τιμές στις συχνότητες που μας 

ενδιαφέρουν. Προσοχή, το βήμα μετακίνησης είναι όσο 

δηλώσαμε κατά το setup του Simulator δηλαδή 0.1GHz. 

  

 

    Στην συνέχεια θα αποθηκεύσουμε την γραφική που μόλις δημιουργήσαμε. Πηγαίνουμε 

File>Save_as και δίνουμε ένα όνομα πχ. Laboratory_1_LPF. Παρατηρούμε ότι 

αποθηκεύεται ως αρχείο με την κατάληξη .dss (data_display server) και συγκεκριμένα στο 

directory_project (lab_2011117 για εμένα). Nα υπενθυμίσω ότι στο ίδιο directory είναι 

αποθηκευμένο το αρχείο Laboratory_1_LPF.dsn που φέρει πληροφορίες για το Schematic.  

 

Για να επαληθεύσουμε τα παραπάνω πηγαίνουμε στο Main Window>Project_View. 

 

 

*Ίσως στο σημείο αυτό είναι κάπως κουραστική η ανάλυση για το που αποθηκεύεται το 

κάθε αρχείο (dsn, dds) ωστόσο θα σας βοηθήσει στην συνέχεια να γνωρίζετε που έχετε 

τοποθετήσει το οτιδήποτε για κάθε project που φτιάχνετε χωρίς προβληματισμό. 

Δεν κλείνουμε το παράθυρο data_display και συνεχίζουμε το επόμενο βήμα. 
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1.2 Η τεχνική του tuning 
 

    Σε αυτό το βήμα θα μάθουμε μία πάρα πολύ σημαντική δυνατότητα που μας δίνει το 

ADS, το tuning. Κάνοντας χρήση αυτού μπορούμε να μεταβάλουμε τις τιμές των στοιχείων 

που έχουμε τοποθετήσει στο Schematic και να βλέπουμε την ίδια στιγμή πως μεταβάλετε η 

γραφική μας (στην περίπτωση αυτή η παράμετρος S21). 

   Πρώτον, προσπαθούμε να τοποθετήσουμε το παράθυρο του Schematic όπως και 

του data display στην οθόνη ώστε να είναι και τα δύο ταυτόχρονα ανοιχτά.  Για να 

έχουμε καλύτερη ανάλυση στο Schematic και αντίστοιχα στο data_display  κάνουμε 

ένα re-size πατώντας το εικονίδιο . 

Πηγαίνοντας στο Schematic παράθυρο, Simulate>Tuning  ή  πατάμε το εικονίδιο  

 

 

   Ανοίγουν δύο παράθυρα. Το ένα είναι για το tuning  

Parameter με κάποιες οδηγίες χρήσης στα δεξιά, ενώ 

το δεύτερο είναι το ίδιο παράθυρο που εμφανίστηκε 

προηγουμένως όταν πατήσαμε να γίνει προσομοίωση 

(F7). 

 

 

Υπάρχουν δύο τρόποι ώστε να δηλώσουμε μία 

παράμετρος διαθέσιμη για tuning. 

 

 

 Ι. H πρώτη είναι να πατήσουμε κλικ, δίπλα στην τιμή του 

πυκνωτή C1 όπως φαίνεται στο παρακάτω σχήμα. Όταν γίνει 

αυτό θα εμφανιστεί ένα παράθυρο με έναν controller.  

 

 

 

  ΙΙ.  Ο δεύτερος τρόπος είναι απλά πατώντας κλικ, πάνω στο εικονίδιο 

του πυκνωτή στο σχηματικό ή πάνω στο αναγραφόμενο C1. Τότε θα 

εμφανιζόταν ένα παράθυρο επιλογής . 
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Όπως και να έχει και με τους δύο τρόπους μπορούμε να μεταβάλουμε την τιμή του 

πυκνωτή C1. Κάνουμε το ίδιο και για το πηνίο L1. Συνεπώς έχουμε δύο controllers 

ανοιχτούς και τη γραφική παράσταση δίπλα ακριβώς. Μεταβάλλουμε τις τιμές του 

πυκνωτή και του πηνίου και παρατηρούμε πως η γραφική παράσταση αλλάζει.  

 

Ο στόχος μας είναι στα 2 GHz το S21=-3 dB (η συχνότητα αποκοπής), ενώ η ζώνη 

διέλευσης πρέπει να είναι όσο πιο ομαλή γίνεται. Αν δούμε ότι για να το πετύχουμε αυτό 

χρειάζονται μεγαλύτερες  τιμές από τα 1.5 pF και nΗ (που είναι από default οι μέγιστες 

τιμές) αλλάζουμε το πεδίο max και το βάζουμε για παράδειγμα στο 6. 

 

Αν για παράδειγμα η τιμή του πυκνωτή C1 είναι 5.4 pF, του πηνίου 3.63 nH και του 

πυκνωτή C2=3 pF η απόκριση του φίλτρου είναι η εξής: 

 

 

 

 

 

 

 

 

 

 

   H απόκριση αυτή δεν είναι άσχημη, ωστόσο υπάρχει ένα βουναλάκι δημιουργώντας μία 

κυμάτωση (Ripple) στην περιοχή διέλευσης πριν την συχνότητα αποκοπής το οποίο ίσως 

επηρεάσει το σήμα που θα περάσει από το φίλτρο (αυτές οι τεχνικές λεπτομέρειες 

εξαρτώνται από πολλές παραμέτρους που δεν θα αναλυθούν στα πλαίσια αυτού του 

βοηθήματος).  

   Τέτοιου είδους κυματώσεις δημιουργούνται όπως αναφέρθηκε στην εισαγωγή από 

φίλτρα της κατηγορίας Chebyshev και Elliptic. Ωστόσο τα φίλτρα αυτά όπως φαίνεται και 

στο σχήμα, έχουν αρκετά απότομη απόκριση σε σχέση πχ. με ένα φίλτρο Butterworth. Για 

να πάρουμε μία αίσθηση για το πόσο απότομη είναι η κλίση (Roll-Off)  μετά την 

συχνότητα αποκοπής θα υπολογίσουμε πόσα dB/octave έχουμε .  

 

 Υπενθύμιση: η οκτάβα ορίζεται ως η διπλάσια συχνότητα από την συχνότητα 

μελέτης. Αρκετές φορές υπολογίζεται και dB/decade, όπου decade είναι η 

δεκαπλάσια συχνότητα. 
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   Βάζουμε τον marker1 στην συχνότητα 2 GHz. Στην συνέχεια 

εισάγουμε έναν δεύτερο marker2 και τον τοποθετούμε στην 

συχνότητα 4 GHz.  Πατώντας δεξί-κλικ στον marker2 εμφανίζονται 

οι εξής επιλογές: Πηγαίνουμε Main>Marker Mode/Delta. Επίσης 

μπορούμε να αλλάξουμε το όνομα του marker. 

 

 

 

Εμφανίζεται η ένδειξη Delta Mode ON, και 

υπολογίζεται η διαφορά των δύο marker με 

αναφορά τον πρώτο. Συνεπώς έχουμε 22 dB/octave. 

 Πατάμε δεξί-κλικ στο marker2 και από την επιλογή 

που εμφανίζεται "Delta/Offset mode OFF" κλείνουμε 

το Delta marker. 

 

 

 

 

1.3 Σχεδιασμός ενός χαμηλοπερατού φίλτρου Butterworth 
 

Στόχος: Τα φίλτρα Butterworth είναι σχεδιασμένα ώστε να έχουν την πιο επίπεδη, χωρίς 

κυμάτωση, ζώνη διέλευσης και είναι ο στόχος για αυτή τη σχεδίαση. Η συχνοτική 

απόκριση ενός τέτοιου φίλτρου έχει την παρακάτω μορφή. 
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  Ανάλογα με τον αριθμό των πηνίων και πυκνωτών που έχει ένα φίλτρο, καθορίζεται και ο 

αριθμός των πόλων του ή η τάξη του φίλτρου. Το φίλτρο που έχουμε σχεδιάσει στο 

Schematic είναι τρίτης τάξης / έχει 3 πόλους (three pole or third order LPF). Γενικά 

όσους περισσότερους πόλους έχει ένα φίλτρο τόσο πιο απότομη γίνεται η απόκριση του. 

Χαρακτηριστική είναι η γραφική παρακάτω για ένα LPF Butterworth. 

 

 

 

    To attenuation σε (dB) ορίζεται ως: |S(2,1)|. Η απόλυτη τιμή σε σχέση με την παράμετρο 

S21 που υπολογίσαμε από το ADS, δηλαδή. Παρατηρώντας αυτή τη γραφική: πρώτον ο 

οριζόντιος άξονας είναι σε σχετικές μονάδες, κανονικοποιημένος ως προς την συχνότητα 

αποκοπής. Συνεπώς για f/fc=1 βρισκόμαστε στη συχνότητα αποκοπής. Πάντα στη 

συχνότητα αποκοπής η εξασθένιση ενός φίλτρου θα είναι κοντά στα 3 dB oπως φαίνεται 

και από το σχήμα.  

 

     Επίσης στο σχήμα υπάρχουν γραφικές ανάλογα με την τάξη του φίλτρου. Όσο 

μεγαλύτερη η τάξη τόσο πιο απότομη η κλίση. To μεγάλο πλεονέκτημα που μας προσφέρει 

αυτός ο πίνακας είναι οτι για δεδομένη συχνότητα πχ. 3 φορές την συχνότητα αποκοπής, 

αν ξέρουμε τι εξασθένιση θέλουμε να πετύχουμε για την εφαρμογή μας, από το γράφημα 

παίρνουμε πληροφορίες για το πόσους πόλους θα χρησιμοποιήσουμε !  

 

3dB 
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 Προσοχή! Το συγκεκριμένο γράφημα ισχύει για LPF Butterworth φίλτρα! Άλλες 

κατηγορίες φίλτρων έχουν άλλα γραφήματα που δεν θα αναλυθούν εδώ! 

 

Οι προδιαγραφές που θα χρησιμοποιήσουμε είναι: 

 

1) Χαμηλοπερατό φίλτρο Butterworth, με 3 πόλους, 

ώστε να μπορέσω να το συγκρίνω με το αντίστοιχο 

που δημιούργησα προηγουμένως. Η συχνότητα 

αποκοπής είναι 2 GHz. 

 

2) Η αντίσταση πηγής και φορτίου είναι 50Ω 

(δεδομένο). 

 

 Με βάση το ότι ο λόγος Rsource/RLoad=1, παίρνουμε 

ως βοήθημα τον διπλανό πίνακα.  

Για n=3 παίρνουμε τις κανονικοποιημένες τιμές 

C1n=C3n=1 και L2n=2. 

 

 

 

 

 

Για να μετασχηματίσουμε σε κανονικές τιμές χρησιμοποιούμε τις εξής πολύ απλές 

φόρμουλες: 

   
           

         
 

 

   
                

    
 

Όπου RLoad είναι η τιμή του φορτίου για το κύκλωμα μας, 50Ω. Κάνοντας τις πράξεις, 

παίρνουμε  C1=C2=1.6 pF και L=8 nH. Αυτές είναι οι τιμές που θα μας δώσουν την 

απόκριση για ένα χαμηλοπερατό φίλτρο Butterworth 3πόλων. 
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1.4 Σύγκριση των δύο φίλτρων 

 

Για να κάνουμε τη σύγκριση με το φίλτρο που σχεδιάστηκε 

αρχικά, κάνουμε τα εξής: 

 Ενώ έχουμε ανοιχτό το tuning, κάνουμε κλικ και τον 

πυκνωτή C2 

 Συνεπώς θα έχουμε πλέον 3 παραμέτρους διαθέσιμες 

για αλλαγή  

 

 

Στην συνέχεια μπορούμε να αποθηκεύσουμε το διάγραμμα που 

φτιάξαμε πατώντας Store όπως φαίνεται στην διπλανή εικόνα.  

Δίνουμε ένα όνομα και πατάμε ΟΚ. 

 

 

    Όταν θα πάμε να μεταβάλουμε κάποια από τις τιμές τώρα, θα δούμε ότι θα δημιουργηθεί 

μία νέα γραφική, ενώ η παλιά με την ονομασία Queen Mary φαίνεται με dashed line.  

 H καινούργια ονομασία θα έχει τον marker1, ενώ μπορούμε να τοποθετήσουμε και 

δεύτερο marker για την παλιά γραφική. 

  Βάζουμε τις καινούργιες τιμές για πυκνωτές και πηνία. Για να μπορούμε να ξεχωρίσουμε 

τις δύο γραφικές πατάμε διπλό-κλικ οπουδήποτε στη γραφική και στη συνέχεια  

Plot Options>Max ώστε ο άξονας y να πηγαίνει μέχρι και τα 10 dB. Aλλάζουμε το όνομα 

των markers (εδώ έχω χρησιμοποιήσει new και old). 
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 Επίσης με την επιλογή Update_Schematic, το ΑDS δίνει αυτόματα τις τιμές που 

εμφανίζονται στο παράθυρο tune parameters, στο σχηματικό! Πατάμε Update και στη 

συνέχεια Close για το tuner.  Δοκιμάστε το για να εξοικειωθείτε με τις λειτουργίες αυτές. 

Το νέο μας σχηματικό έχει αυτή τη μορφή: 

 

 
 

  Δίπλα στις τιμές του κάθε στοιχείου που υπάρχει στο σχηματικό υπάρχει το σύμβολο {t}. 

Συνεπώς κάθε φορά που θα πατήσουμε το σύμβολο του tuning θα είναι διαθέσιμα τα 

στοιχεία αυτά για την εφαρμογή του tuning. Αν δεν θέλουμε κάποιο στοιχείο να είναι 

διαθέσιμο για την λειτουργία αυτή πατάμε διπλό-κλικ: Tune/Opt/….>Tuning>Clear 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 Πατάμε Save τόσο στο παράθυρο Schematic όσο και στο data_display παράθυρο. 

Έπειτα κλείνουμε και τα δύο. Το μόνο που θα μείνει ανοιχτό είναι το Main_Window. 
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Μέρος 2. Χρήση ενός παραδείγματος του ADS 

 
 Εισαγωγή 
 

 Στο design που θα ακολουθήσει, θα μεταφέρουμε ένα έτοιμο σχηματικό από τα 

παραδείγματα που προσφέρει το ADS. Θα δείξουμε πως γίνεται μεταφορά αρχείων 

από ένα directory σε ένα άλλο. Στην συνέχεια θα μάθουμε πως τοποθετούμε Pin 

Label στους ακροδέκτες των στοιχείων υπό μελέτη, πως γράφουμε εξισώσεις στο 

ADS και πως σχηματίζουμε πίνακες με τα δεδομένων των εξισώσεων που έχουμε 

δημιουργήσει. 

 

  2.1 Μεταφορά αρχείων μεταξύ Directory 
 

   Πηγαίνουμε στο Main Window> File View. Πατάμε το εικονίδιο View Example Directory.   

Eμφανίζεται μία λίστα με παραδείγματα διαθέσιμα απο το ADS.  

   Στην συνέχεια πατάμε το View_Current_Working_Directory για να σιγουρευτούμε ότι 

βρισκόμαστε στο lab_2011117 project. 

 

 Πηγαίνουμε File>Copy Design και εμφανίζεται ένα παράθυρο: 

 

 
 

 Επιλέγουμε από το From Design, το Example Directory και στη συνέχεια 

Browse>RFIC>amplifier_prj>networks>HBtest.dsn και άνοιγμα. 

 

 Απο το To path, επιλέγουμε Working Directory και πατάμε ΟΚ. 

 

Πηγαίνοντας στο Main Window>Project_View, θα δούμε ότι υπάρχει το αρχείο ΗΒtest.dsn. 

 

 Έπειτα στο File View>New Schematic Window  

 

 Αφού ανοίξει το καινούργιο σχηματικό, πηγαίνουμε File>Open Design 
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και επιλέγουμε το HBtest.dsn. Αφού το ανοίξουμε κάνουμε Save as και δίνουμε 

όνομα Laboratory_2_Example.dsn.  

 

 Αν θέλουμε να σβήσουμε το αρχικό HBtest.dsn πηγαίνουμε Main Window>View 

Project, δεξί κλικ στο αρχείο HBtest.dsn και Delete. 

 

 
  

 Μπορούμε να σχολιάσουμε βλέποντας το σχηματικό: 

 

   Για πηγή χρησιμοποιείται το V_1Tone που παράγει ένα ημίτονο τάσης 0.1Volt με 

συχνότητα 960MHz. Η πηγή αυτή βρίσκεται στην παλέτα Sources Freq Domain. 

Στην ίδια παλέτα βρίσκεται και η πηγή σταθερής τάσης V_DC. 

 

   Για Simulator εδώ χρησιμοποιείται το Harmonic Balance. Θα το συναντήσουμε 

αρκετά στην συνέχεια. Είναι πολύ κλασικός προσομοιωτής και βρίσκεται στην 

Simulation HB παλέτα. Εκεί μπορούμε να ορίσουμε την τάξη των αρμονικών που 

θα προκύψουν από την μελέτη του κυκλώματος. 

 

   Το "κουτί" με το Var_Eqn θα αναλυθεί αργότερα. Ουσιαστικά υποδηλώνει δύο 

μεταβλητές:  Cseries και Lshunt. 
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  Πατώντας δεξί-κλικ πάνω στο "κουτί" με την ονομασία PA σχηματίζεται ένα 

μαύρο πλαίσιο γύρω του.  

 

 

  Στην συνέχεια βρίσκουμε το εικονίδιο Push Into Hierarchy και πατάμε κλικ. 

 

 
 
 Αυτή είναι η εικόνα που παίρνουμε. Αυτό σημαίνει ότι το "κουτί" στο σχηματικό PA, 

περιέχει μέσα του αρκετά κυκλώματα. Εμείς στο σχηματικό βλέπουμε μονάχα τους 

ακροδέκτες εισόδου και εξόδου του κυκλώματος. Ο τρόπος αυτός ιεραρχικής οργάνωσης 

των κυκλωμάτων είναι πολύ σημαντικός και όπως θα δούμε παρακάτω θα σχεδιάσουμε 

και εμείς ένα κύκλωμα (όχι τόσο σύνθετο) και θα το βάλουμε σε "κουτί" με τους 

ακροδέκτες εισόδου και εξόδου να είναι εμφανής στο σχηματικό. 

 

 Για να επιστρέψουμε στο σχηματικό πατάμε Pop-Out    
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2.2 Δημιουργία Pin Label και Harmonic Balance Setup 

 
 

   Κάνοντας διπλό-κλικ στον HB-Simulator πάνω στο 

σχηματικό, το πρώτο tab που ανοίγει "Freq" περιέχει 

πληροφορίες για το πλήθος των αρμονικών που θα 

εμφανιστούν στο αποτέλεσμα της προσομοίωσης.     

 Πηγαίνουμε στο Order και γράφουμε 6, μετά πατάμε Apply 

και ΟΚ. 

  
 Μπορούμε να παρατηρήσουμε ότι στο σχηματικό υπάρχει 

στην έξοδο μία ταμπέλα "Vout". Αυτή η ένδειξη ουσιαστικά 

υπολογίζει την τάση στο σημείο αυτό του κυκλώματος. 

 

 

 

 

 Εμείς θέλουμε να βάλουμε επίσης μία ταμπέλα Vin στην είσοδο του ενισχυτή. 

 
 Πατάμε το εικονίδιο Ιnsert Wire/Pin Label 

 

 Αν χρειαστεί να αφαιρέσουμε την ταμπέλα από κάποιον ακροδέκτη πηγαίνουμε: 

Εdit> Wire/Pin Label// Remove Wire/Pin Label 

  

 Στη συνέχεια γράφουμε Vin, πατάμε κλικ πάνω στο καλώδιο που μπαίνει στην 

είσοδο του ενισχυτή και μετά Close. 

 

 Προσοχή! Το ADS κάνει διάκριση μεταξύ μικρών-κεφαλαίων γραμμάτων:(Vin-vin)  

 

 
Πατάμε Save το σχηματικό και στην συνέχεια Simulate, F7. Το παράθυρο data_display 

ανοίγει! 
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2.3 Δημιουργία Equation&List 

 
   Θέλουμε να δούμε την ισχύ των αρμονικών συχνοτήτων στην έξοδο του ενισχυτή. 

 Ενώ είμαστε στο data_display, πηγαίνουμε Rectangular Plot>Vout>Spectrum in dBm. 

 

 
 

Στην γραφική που ανοίγει βάζουμε δύο marker έναν στην 1η αρμονική (θεμελιώδη 

συχνότητα 960MHz) και έναν market στη 2η αρμονική. 

 

 
Στην συνέχεια πηγαίνω στην λίστα αριστερά και βρίσκω το εικονίδιο Equation  

 To τοποθετώ οπουδήποτε και ανοίγω ένα καινούργιο παράθυρο  
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   Στο χώρο αυτό μπορούμε να γράψουμε την εξίσωση που επιθυμούμε 

VoltageGain=Vout/Vin. Nα τονίσω ότι η τιμές Vout και Vin βρίσκονται στην λίστα που 

βρίσκεται στο παράθυρο αυτό και έχουν υπολογιστεί από τα Pin Label που έχουμε 

τοποθετήσει στο σχηματικό3. 

 

 
 

 

Στο παράθυρο data_display εμφανίζεται τελικά  
 

 

Έπειτα εισάγουμε μία λίστα από το εικονίδιο.   

 

 

 

  Στο παράθυρο που  εμφανίζεται  επιλέγουμε Plot 

Type>Datasets and Equations> Equations και από 

εκεί την επιλογή της εξίσωση που δημιουργήσαμε 

VoltageGain. 

 

 

 
  Κάνουμε save as το data_display με το ίδιο όνομα 

που χρησιμοποιήσαμε για το σχηματικό και το 

κλείνουμε. Επίσης κλείνουμε και το σχηματικό.  

 

   Μόνο το Main_Window μένει ανοιχτό. 

                                                        
3 Για περισσότερες εξισώσεις: ADS http://cp.literature.agilent.com/litweb/pdf/ads15/express/exp022.html 
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Μέρος 3. Σχεδιασμός κυκλωμάτων RLC  

 

   Εισαγωγή 
 

      Τα κυκλώματα RLC ή αλλιώς κυκλώματα συντονισμού (Resonant or Tuning circuits) 

είναι πολύ δημοφιλή με πολλές εφαρμογές. Εμείς θα ασχοληθούμε με την σχεδίαση ενός 

απλού ζωνοπερατού φίλτρου. Αποτελούνται από μία αντίσταση, ένα πηνίο και ένα 

πυκνωτή. Υπάρχει μία συχνότητα του κυκλώματος αυτού, όπου η εμπέδηση (inductive 

reactance) του πηνίου γίνεται ίση με την τιμή της εμπέδησης του πυκνωτή (capacitive 

reactance). Η συχνότητα αυτή αντιστοιχεί στην συχνότητα συντονισμού του κυκλώματος. 

 

 Η συχνότητα συντονισμού ορίζεται ως :      
 

   
 

 

     Για να συντονίσει το κύκλωμα με μία δεδομένη συχνότητα πχ. ένα ραδιοφωνικό σταθμό, 

συχνά κρατάμε σταθερή την τιμή του πηνίου και μεταβάλουμε την τιμή του πυκνωτή. Για 

αυτό το λόγο συχνά οι πυκνωτές σε κυκλώματα συντονισμού ονομάζονται και "tuning 

capacitors " 

 

 

    Ένα απλό κύκλωμα συντονισμού είναι το διπλανό και 

αποτελείται από μία αντίσταση εισόδου και μία 

αντίσταση εξόδου, ένα πηνίο και ένα πυκνωτή. 

 

 

 

 

Για τον υπολογισμό του συντελεστή ποιότητας ενός κυκλώματος 

συντονισμού είναι πιο βολικό να υπολογίσουμε το ισοδύναμο 

κύκλωμα ορίζοντας ως ολική αντίσταση: 

 

 
      

    
     

 

 

O συντελεστής ποιότητας ορίζεται ως: 
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Ο συντελεστής ποιότητας για ένα φίλτρο 

ορίζεται και  ως ο λόγος της κεντρικής 

συχνότητας=συχνότητα συντονισμού, προς 

το εύρος ζώνης του φίλτρου. 

 

  
  

          
 

 

   

 

 Συνεπώς όσο πιο υψηλή τιμή παίρνει το Q, τόσο πιο στενό το εύρος ζώνης άρα και 

η επιλεκτικότητα του φίλτρου. 

 

  Για διευκόλυνση θα θεωρήσουμε ότι η τιμή του φορτίου RLoad είναι πολύ μεγαλύτερη 

σε σχέση με την τιμή της πηγής Rsource. Συνεπώς το Rtotal=Rsource και Q=Rsource/(Xc=XL). 

Στο κύκλωμα που θα κατασκευάσουμε πρακτικά σημαίνει ότι: εφόσον η τιμή του 

φορτίου έχει πολύ μεγάλη τιμή, μπορεί στο σχηματικό να θεωρηθεί ανοιχτό κύκλωμα.  

    

   Στην εργασία αυτή θα αναλυθούν δύο αρχιτεκτονικές: μία με μικρό συντελεστή 

ποιότητας και μία μεγάλο συντελεστή ποιότητας για την ίδια συχνότητα 

συντονισμού. Θα μάθουμε πως δημιουργούμε σύμβολα ("κουτιά" δηλαδή που 

περιέχουν πολλά στοιχεία). Στην συνέχεια θα δούμε μία εφαρμογή του κυκλώματος 

RLC. Στην προσπάθεια μας να δεχτούμε μία μόνο συχνότητα από τις διάφορες που 

εκπέμπονται από διάφορους ραδιοφωνικούς σταθμούς, θα πρέπει να σχεδιάσουμε 

κατάλληλο κύκλωμα συντονισμού στην επιθυμητή συχνότητα.  
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3.1 Σύγκριση δύο κυκλωμάτων RLC με διαφορετικό Q 
 

    Aνοίγουμε ένα καινούργιο σχηματικό και το ονομάζουμε Laboratory_3A_RLC. Στην 

συνέχεια πηγαίνουμε στην παλέτα Sources-Freq Domain και επιλέγουμε την πηγή V_AC. 

Η πηγή αυτή τάσης, μας δίνει τη δυνατότητα να κάνουμε σάρωση σε μία ομάδα 

συχνοτήτων. Για να γίνει αυτή η σάρωση χρειαζόμαστε ένα Simulator και συγκεκριμένα 

πηγαίνουμε στην παλέτα Simulation-AC και επιλέγουμε τον πρώτο Simulator ΑC.    

  Τοποθετούμε επίσης αντίσταση, πυκνωτή και πηνίο όπως το παρακάτω σχήμα. Επίσης 

στα καλώδιο εισόδου και εξόδου του κυκλώματος βάζουμε Pin Label ως Vin και Vout αφού 

θα πρέπει να σχεδιάσουμε την χαρακτηριστική του κυκλώματος. 

 

 

   Με βάση τους τύπους που αναφέραμε παραπάνω, το συγκεκριμένο κύκλωμα έχει 

συχνότητα συντονισμού ~142MHz  και ο συντελεστής ποιότητας αντιστοιχεί σε 

Q=50/(2*pi*142MHz*50nH)~1.12. Μπορούμε να υποθέσουμε ότι το φίλτρο αυτό θα έχει 

πολύ κακή επιλεκτικότητα (Selectivity).  

 

 Πατάμε Simulate, F7. 
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 Στο παράθυρο data_display που ανοίγει, εισάγουμε την εξίσωση: 

 

 
 

Στην συνέχεια εισάγουμε την γραφική παράσταση αυτής της εξίσωσης σε συνάρτηση με 

την συχνότητα (αυτόματα θα γίνει αυτό αφού κάνουμε AC Sweep σε συγκεκριμένο εύρος 

συχνοτήτων). 

 
 

 Πράγματι το φίλτρο αυτό έχει πολύ κακή επιλεκτικότητα. Η συχνότητα 

συντονισμού είναι όσο την υπολογίσαμε θεωρητικά. 

 

Επιστρέφουμε στο σχηματικό. Τοποθετούμε tuners στην αντίσταση, πηνίο & πυκνωτή. 
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 Για να βελτιώσουμε την επιλεκτικότητα του φίλτρου έχουμε δύο λύσεις: 

 

 I. Κρατάμε σταθερή την τιμή της αντίστασης 50Ω και με κατάλληλο συνδυασμό πηνίου 

και πυκνωτή (ώστε να πετύχουμε ίδια συχνότητα συντονισμού) βάζουμε ως στόχο χαμηλή 

τιμή για το πηνίο και υψηλή για τον πυκνωτή. 

 

II. Κρατάμε σταθερή τιμή για τον πυκνωτή και το πηνίο, και απλά αυξάνουμε την τιμή της 

αντίστασης. 

 
  Πριν κάνουμε οτιδήποτε και ενώ είμαστε στο tuner κάνουμε Store την γραφική με 

Q=1.12, ώστε αλλάζοντας μετά τις τιμές του κυκλώματος να βλέπουμε πως μεταβάλλεται 

η νέα γραφική. 

     Για το πρώτο σενάριο τοποθετούμε τιμές στο tuner L=2.5 nH και C=500 pF . Κρατάμε 

ανοιχτό το παράθυρο του data_display. 

 

 
Η νέα γραφική έχει συντελεστή ποιότητας Q=50/(2*pi*142MHz*2.5nH)~22.4 ! 

 

    Μπορούμε να το επαληθεύσουμε παίρνοντας επίσης τον λόγο της συχνότητας 

συντονισμού με το εύρος ζώνης του φίλτρου! 

 

 Μεταβάλλετε με το tuner την τιμή του πυκνωτή (tuning Capacitors) ή του 

πηνίου και δείτε πως η συχνότητα συντονισμού του φίλτρου μετακινείται ! 
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Κάνουμε Save το data_display αρχείο με το ίδιο όνομα όπως το σχηματικό και κλείνουμε τα 

πάντα! 

   

 

 3.2 Δημιουργία συμβόλου  

 
      Ανοίγουμε ένα νέο σχηματικό. Στην συνέχεια πηγαίνουμε File>Open Design και 

ανοίγουμε το σχηματικό  που μόλις φτιάξαμε: Laboratory_3A_RLC.dsn. Πηγαίνουμε Save as 

και δημιουργούμε ένα καινούργιο σχηματικό Laboratory_3B_RLC.dsn. 

 

  Aφαιρούμε από τα στοιχεία που χρησιμοποιήσαμε (πυκνωτή, πηνίο και αντίσταση) τα 

tuner που βάλαμε προηγουμένως, κάνοντας διπλό-κλικ πάνω τους. 

 

 
 

 
 Στην συνέχεια αφήνουμε την τιμή της αντίστασης 50 Ω, το πηνίο παίρνει την τιμή 

L=5 nH και ο πυκνωτής 532 pF. Aλλάξαμε την συχνότητα συντονισμού στα 

97.5MHz καθώς ο σκοπός μας όπως θα φανεί αργότερα είναι να φτιάξουμε 

ένα κύκλωμα λήψης για ραδιοφωνικούς σταθμούς στα FM. 
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Αλλάζουμε το βήμα του Simulator σε 0.1MHz και τελικά το σχηματικό είναι αυτό: 

 

 
 

 Πατάμε Simulate, F7. 

 

  Φτιάχνουμε την ίδια εξίσωση για το Response και στην γραφική παράσταση 

τοποθετούμε έναν marker ένδειξης της μέγιστης τιμής (Insert a Peak Marker) 

  Έπειτα κάνουμε Save τη νέα γραφική παράσταση. 

 

 
 Eπιστρέφουμε στο σχηματικό και κάνουμε Save.  

 Έπειτα κάνουμε Save_as Laboratory_3C_BoxRLC.dsn.  
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 Διαγράφουμε την πηγή όπως και τον Simulator και τοποθετούμε θύρες (Ports). 

Επίσης πατάμε σε καθένα από τα στοιχεία διπλό κλικ και κάνουμε 

Tune/../Tuning/Enable 

  

 
   Για να δημιουργήσουμε σύμβολο πηγαίνουμε, View>Create/Edit Schematic Symbol. Ένα 

νέο παράθυρο ανοίγει. Πατάμε ΟΚ και δημιουργείται ένα "κουτί" με δύο θύρες. 

 
 Πατάμε ξανά View>Create/Edit Schematic Symbol και 

επιστρέφουμε στο σχηματικό. 

 Πατάμε Save και έπειτα πάμε File> Design Parameters  

 

 Στο Component Instance Name γράφουμε: BoxRLC  

 

 Artwork>Type>None 

 

 To Description το αφήνουμε όπως έχει, αλλά πρέπει να 

θυμόμαστε το όνομα του, γιατί αργότερα που θα πρέπει να 

ανακτήσουμε το σύμβολο που φτιάχνουμε τώρα από την 

βιβλιοθήκη. Μπορούμε να δηλώσουμε για όνομα πχ. RLC_package.    

  

 Πατάμε Save AEL File και ΟΚ και κλείνουμε τα πάντα. Μόνο το Main Window μένει 

ανοιχτό. 
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3.3  Επιλογή επιθυμητού ραδιοφωνικού σταθμού 

 

 
  Ανοίγουμε καινούργιο σχηματικό και το ονομάζουμε Laboratory_3D_RadioFM.dsn 
 Στην συνέχεια βρίσκουμε το εικονίδιο της βιβλιοθήκης. Πηγαίνουμε 

Projects>lab_2011117 και βρίσκουμε το στοιχείο με την περιγραφή που δώσαμε στην 

δημιουργία συμβόλου. Πατάμε κλικ και το εισάγουμε μέσα στο νέο μας σχηματικό. 

 

 
Πηγαίνουμε στην παλέτα Sources Freq-Domain και επιλέγουμε την V_nTone γεννήτρια.  

 

 Σκοπός μας είναι να δημιουργήσουμε τρεις συχνότητες που η καθεμία θα 

αντιστοιχεί σε ένα ραδιοφωνικό σταθμό. 

 
Οι επιλογές που έχουμε είναι : 

 

 Freq[1]=105.2 MHz (Atlantis FM) 

 

 Freq[2]=97.5 MHz (Love FM) 

 

 Freq[3]=87.7 MHz (En Lefko FΜ) 
 

Πατάμε διπλό κλικ στην γεννήτρια. Δηλώνουμε όπου 

Freq[1]  την αντίστοιχη συχνότητα πατάμε Apply. Μετά 

πατάμε Add για να προσθέσουμε και τις άλλες δύο. Την ίδια 

διαδικασία ακολουθούμε για την δήλωση της τάσης για 

κάθε τάση. Βάζουμε σε όλες 0.01 Volt. 
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      Για να εισάγουμε τις τρείς συχνότητες στο σύστημα πηγαίνουμε στην παλέτα 

Simulation-HB και επιλέγουμε τον HB-Simulator.  Εκεί δηλώνουμε με τον ίδιο τρόπο 

ακριβώς τις συχνότητες κάνοντας Add και Apply. Προσοχή! Πρέπει η συχνότητα Freq[1] 

στην γεννήτρια και στον Simulator να έχει την ίδια τιμή. Επίσης για αρμονικές βάζουμε 

1 δηλαδή θέλουμε μόνο την θεμελιώδη να υπολογίσει. Τελικά το σχηματικό είναι έτσι: 

 
 

   Πατάμε στο "κουτί" που δημιουργήσαμε "BoxRLC1" και στην συνέχεια Push In Hierarchy.  

Ανοίγει ένα παράθυρο με το κύκλωμα που σχεδιάσαμε προηγουμένως. Όλα τα στοιχεία 

έχουν το σύμβολο του tuning και είναι έτοιμα για χρήση. Να θυμίσω ότι οι τιμές αυτές 

αντιστοιχούν σε φίλτρο με συχνότητα συντονισμού στα 97.5 MHz δηλαδή στον 

LOVE FM. Οι άλλες συχνότητες που βρίσκονται δίπλα θα εξασθενήσουν σε ένα βαθμό. Το 

πόσο θα εξασθενήσουν εξαρτάται από την επιλεκτικότητα του φίλτρου. 

 

 
 

 

 Επιστρέφουμε στο σχηματικό. 

 

 Κάνουμε Save και πατάμε Simulate, F7. 
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Στο data_display παράθυρο φτιάχνουμε δύο ξεχωριστές 

γραφικές παραστάσεις για το Vin. 

 

 Φτιάχνουμε μία γραφική πατώντας Time domain 

signal και ΟΚ 

 Φτιάχνουμε την δεύτερη για Spectrum in dBm 

 

 

 
 
Aυτή είναι η εικόνα που έχουμε στην είσοδο του δέκτη μας. Όλα τα σήματα μαζί. Στην 

έξοδο τώρα, κάνουμε το ίδιο για το σήμα Vout. 
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     Το σήμα είναι ακόμα παραμορφωμένο αν και ο Atlantis έχει μειωθεί κατά 11 dB και ο 

ΕnLefko κατά 8 dB4. Η τιμή της εξασθένησης είναι γνωστή σε κάθε συχνότητα του φίλτρου 

αυτού, αφού στην προηγούμενη άσκηση που κάναμε την σχεδίαση του, μελετήσαμε και 

την συχνοτική απόκριση. 

 

 

 Πηγαίνουμε στο σχηματικό μας και πατάμε Tuning  

Εμφανίζονται οι μεταβλητές που έχουμε δηλώσει.  

Για να βελτιώσουμε την επιλεκτικότητα του φίλτρου το πιο 

απλό που μπορούμε να κάνουμε είναι να αυξήσουμε την τιμή 

της αντίστασης. Πράγματι για τιμή 500 Ω έχουμε σχεδόν 

καθαρό το ημίτονο του σταθμού που θέλουμε, όπως φαίνεται 

και παρακάτω. 

 
 Αν μεταβάλουμε τις τιμές του πυκνωτή και του πηνίου θα αλλάξει η συχνότητα του 

συντονισμού όπως δείξαμε και στην προηγούμενη άσκηση.  

 Κάνετε διάφορες δοκιμές. 

 Περισσότερες πληροφορίες για τα κυκλώματα RLC θα βρείτε στις διαφάνειες του 

κ.Ματακιά/μάθημα 9ο 

 
 Πατάμε Save to data_display με το ίδιο όνομα που δώσαμε στο σχηματικό. 

 Κλείνουμε τα πάντα. 

 Μόνο το Main_Window μένει ανοιχτό. 

                                                        
4 Η επιλογή των συγκεκριμένων ραδιοφωνικών σταθμών είναι τυχαία και δεν υπάρχει 
σκοπιμότητα διαφήμισης.  Οι συχνότητες των παραπάνω ραδ. σταθμών διευκολύνουν τους 
στόχους της άσκησης υπό μελέτη. 
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Yποσημείωση_1: Οι περισσότεροι προσομοιωτές που χρησιμοποιεί το ADS, στην 

πραγματικότητα  είναι όργανα μέτρησης. Συγκεκριμένα το φάσμα των συχνοτήτων που 

μελετήσαμε προηγουμένως στην πράξη το υπολογίζουμε με ένα φασματογράφο 

(Spectrum Analyzer) όπως φαίνεται στην εικόνα αριστερά. Αντίστοιχα τις S-Parameters & 

χάρτη Smith τα μετράμε με ένα όργανο μέτρησης που ονομάζεται Network Analyzer και 

φαίνεται στην εικόνα δεξιά. 

 

 

Yποσημείωση_2: Υπάρχουν αρκετές επιλογές για την επεξεργασία των γραφικών 

παραστάσεων του ADS θα παρουσιάσουμε μερικές από τις πιο σημαντικές. 

 

 

 

 Για αύξηση του μεγέθους της 

γραμματοσειράς, πατάμε μονό-

κλικ στην γραφική και 

έπειτα/text/14 point,16 κτλ 

 

 Για αύξηση του πάχους των 

γραφικών παραστάσεων πατάμε 

πάνω στην καμπύλη Item 

options/Trace options/Spectral 

(ή linear, εξαρτάται από το είδος 

της γραφικής) 

 

Αν ψάξει παραπάνω κάποιος μπορεί να βρεις και άλλες επιλογές που μπορούν να του 

φανούν χρήσιμες.  

 Αρκετά χρήσιμο είναι η εισαγωγή σχολίων δίπλα στην γραφική. Πατάμε το κουμπί 

"Α" που βρίσκεται στην μπάρα αριστερά για να γράψουμε κάποιο σχόλιο. Αν 

θέλουμε να βάλουμε και κάποιο περίγραμμα τοποθετούμε το ορθογώνιο που 

βρίσκεται ακριβώς πάνω του. 
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Μέρος 4.  Σχεδιασμός Ενισχυτή 

 

 Εισαγωγή 
   

      Αφού είδαμε πως γίνεται να κατασκευάσουμε κυκλώματα και στη συνέχεια να τα 

βάλουμε σε "κουτιά" (symbol_create in ADS), τώρα θα χρησιμοποιήσουμε κάποια 

έτοιμα "κουτιά" που μας δίνει το ADS (συγκεκριμένα έναν ενισχυτή) και θα 

καθορίσουμε τις παραμέτρους του.  Επίσης θα δείξουμε την διαδικασία της σάρωσης 

"Sweep" κάποιων μεταβλητών που έχουμε δηλώσει. Στο τέλος θα γίνει μελέτη 

υπολογισμού του σημείου συμπίεσης  1dB για έναν ενισχυτή. 

 

  4.1 Δήλωση παραμέτρων ενός ενισχυτή 
  

  Η πρώτη διάταξη που θα μελετήσουμε είναι ένας ενισχυτής. Αφού μπροστά μας έχουμε 

μόνο το Μain_Window, πατάμε New_Schematic Window για να δημιουργήσουμε ένα νέο 

σχηματικό. 

 

  Πηγαίνοντας στην περιοχή που διαλέγουμε παλέτες, βρίσκουμε την 

System_Amps&Mixers παλέτα. Από εκεί επιλέγουμε το πρώτο εικονίδιο άνω αριστερά 

Amplifier2.  To τοποθετούμε στο σχηματικό. Επίσης από την Sources_Freq Domain 

παλέτα επιλέγουμε την πηγή P_1 Tone !  Η πηγή αυτή είναι γεννήτρια μίας και μοναδικής 

συχνότητας. Επίσης τοποθετούμε ένα τερματισμό Term, από την Simulation-S_Param 

παλέτα. Αφού βάλουμε γειώσεις το σχηματικό μας τελικά πρέπει να είναι έτσι. 

 

 
 

  Η πηγή γράφει polar(dbmtow(0),0). H πρώτη παρένθεση αναφέρεται σε 0 dBm που είναι 

τιμή ισχύος, ενώ η δεύτερη αναφέρεται στην φάση.  Σβήνουμε το 0 μέσα στην πρώτη 

παρένθεση και γράφουμε Pin: 
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   Στην πραγματικότητα δημιουργήσαμε μία μεταβλητή με το όνομα Pin. Για να 

εκχωρηθεί σωστά στο σύστημα βρίσκουμε το εικονίδιο εκχώρησης μεταβλητών, 

(βρίσκεται δίπλα στην γείωση) και το τοποθετούμε στο σχηματικό. 

 

 

 

   Πατώντας διπλό κλικ στο VAR, εκχωρούμε το 

όνομα της μεταβλητής και δίνουμε μία αρχική  

τιμή -20 πατάμε Apply και ΟΚ. 

 

 

 

 

 

 

   Έπειτα από την Simulation ΗB παλέτα τοποθετούμε στο σχηματικό έναν Harmonic 

Balance Simulator. Ανάλογα με την πηγή και τι ακριβώς θέλουμε να κάνουμε στην 

προσομοίωση τοποθετούμε και τον ανάλογο Simulator. 

 

 
 

  O Simulator αναγράφει Freq[1]=1 GHz. Αυτή είναι η τιμή συχνότητας που θα πρέπει να 

έχει και η πηγή μας P_1Tone. Αν έχουν διαφορετικές τιμές θα εμφανίσει σφάλμα όταν πάμε 

να τρέξουμε για αποτελέσματα. Επίσης το Order[1]=3 δηλώνει ότι μπορεί να υπολογίσει 

μέχρι και την τρίτη αρμονική συχνότητα (η θεμελιώδης 1 GHz, θεωρείται η πρώτη 

αρμονική). 
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  Κάτω από τον ενισχυτή είναι οι S-Parameters του, που έχουν να 

κάνουν με τις σχέσεις  τάσεων εισόδου και εξόδου του ενισχυτή. Θα 

ασχοληθούμε με την S21 και S11. Η παράμετρος S21 εκφράζει το λόγο 

εξόδου προς την είσοδο. Για έναν ενισχυτή αυτό ισοδυναμεί με το 

κέρδος του.  

  

   Συνεπώς το πρώτο μηδενικό είναι η ενίσχυση εκφρασμένο σε dB ( 0 dB=1 ενίσχυση), ενώ 

το δεύτερο μηδενικό είναι η φάση. Για ενίσχυση δηλώνουμε 20 και την φάση την 

αφήνουμε όπως έχει. 

 

 Πράγματι το ADS μας προσφέρει πάρα πολλές επιλογές παραμετροποίησης και είναι 

λογικό κάποιες φορές να υπάρξει προβληματισμός. 

 

   Στο σχηματικό υπάρχουν πολλές ταμπέλες με δεδομένα. Αν θέλουμε 

να μετακινήσουμε για παράδειγμα την ταμπέλα με τις πληροφορίες 

των S παραμέτρων του ενισχυτή πατάμε το F5 και στην συνέχεια 

πάνω στο στοιχείο που μας ενδιαφέρει. Πατώντας πάνω στον 

ενισχυτή πχ, εμφανίζεται ένα μαύρο κουτί που σημαίνει ότι είμαστε έτοιμοι για την 

μεταφορά. 

 

 

    Επίσης μπορεί να μην μας ενδιαφέρει να 

βλέπουμε στο σχηματικό όλες τις παραμέτρους. 

Πατάμε διπλό κλικ στον ενισχυτή . Επιλέγουμε 

την παράμετρο που μας ενδιαφέρει να ΜΗΝ 

εμφανίζεται στο σχηματικό και βγάζουμε το 

"τικ" από το Display parameter on Schematic. 

Αντίστοιχα μπορούμε να κάνουμε το ίδιο για 

παραμέτρους που θέλουμε να εμφανίζονται 

στο σχηματικό.  

 

 

 

 

     Επίσης στο ίδιο σημείο υπάρχει η επιλογή να πατήσουμε Help. Θα ανοίξει μία 

σελίδα με παρά πολλές πληροφορίες για τις παραμέτρους και την λειτουργία του 

ενισχυτή μοντέλου Amplifier2. 
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  Eπίσης για να μάθουμε περισσότερες πληροφορίες 

για μία διάταξη πριν την τοποθετήσουμε στο 

σχηματικό: Πηγαίνουμε στην παλέτα και ακουμπάμε 

τον κέρσορα πάνω σε ένα στοιχείο. Εμφανίζεται η 

επιλογή Press F1 for more help. 

 

 

 

 

 Συνεχίζοντας, πατάμε διπλό κλικ στο σύμβολο 

του ενισχυτή. 

 

α) Aπενεργοποιούμε την επιλογής εμφάνισης 

στο σχηματικό των παραμέτρων S11, S12, S22  

 

b) Οπου GainCompSat= το αφήνουμε κενό  

    Για GainComp το αφήνουμε όπως έχει 1 dB 

ενώ η ισχύς ΕΞΟΔΟΥ του ενισχυτή για την 

οποία έχουμε συμπίεση κατά GainComp (1 dB) 

ισούται με GainCompPower= 8 (dBm εννοείται). 

Πατάμε Apply και ΟΚ. 

 

 

 

 

   Επίσης τοποθετούμε στο σχηματικό στην είσοδο του ενισχυτή ονομασία (Pin Label) Vin, 

ενώ στην έξοδο του Vout με τον τρόπο που έχουμε εξηγήσει. 

 

 

 Ο αρχικός μας στόχος είναι να δούμε αν τελικά ο ενισχυτής κάνει την ενίσχυση που 

περιμένουμε (20 dB) και αν εμφανίζονται στην έξοδο του αρμονικές και ποιες είναι 

οι στάθμες ισχύος αυτών.  

 

    Κάνουμε Save_as το σχηματικό:  Laboratory_4Α_Harmonics.dsn και πατάμε, F7. Στο 

παράθυρο data_display σχεδιάζουμε μία γραφική του Vout σε dBm συναρτήσει της 

συχνότητας όπως κάναμε και στην ενότητα.  
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     Αυτό είναι το φάσμα εξόδου του ενισχυτή. Πράγματι η συχνότητα 1GHz υπολογίζεται 

ως Pout{1GHz}=Pin+Gain{1GHz}, με είσοδο -20dBm και κέρδος 20 dB. H γραφική είναι 

σωστή. Η δεύτερη αρμονική δεν φαίνεται καθόλου καθώς έχει χαμηλή τιμή ενώ τρίτη έχει 

τιμή -46dBm. Aυτή είναι η συμπεριφορά ενός ενισχυτή που λειτούργει στην γραμμική του 

περιοχή ( οι αρμονικές έχουν χαμηλές τιμές και η βασική συχνότητα έχει ισχύ ανάλογη του 

κέρδους του ενισχυτή) αφού η έξοδος του είναι μακριά από το σημείο εξόδου 8 dBm που 

αρχίζει ο κορεσμός.  

 

    Ωστόσο, αν η ισχύς εξόδου φτάσει κοντά στην μέγιστη ισχύ εξόδου που ο ενισχυτής 

αντέχει (8 dBm) θα παρατηρήσουμε ότι η τρίτη αρμονική αποκτά μεγαλύτερη ισχύ, ενώ η 

θεμελιώδης αρχίζει να χάνει ισχύ. 

 

   Για να το δούμε αυτό, στο σχηματικό βάζουμε ένα tuner στην μεταβλητή Pin.  

   Στην συνέχεια κάνουμε δοκιμές για να διαπιστώσουμε τα προαναφερθέντα 
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4.2 Τεχνική του Sweep και 1dB.Compression Point 

 
    

Για να γίνει πιο κατανοητή η σχέση μεταξύ του κέρδους και της 

ισχύος εισόδου του ενισχυτή θα κάνουμε μία σάρωση "Sweep" για 

διάφορες τιμές ισχύς εισόδου (μεταβλητή Pin).  

Κάνουμε Save_as, το Lab_4Α_Harmonics.dds που μόλις 

δημιουργήσαμε  , το κλείνουμε και πάμε στο σχηματικό.  

 

  

 

  Κάνουμε διπλό κλικ πάνω στον Simulator>Sweep tab και γράφουμε Pin στο πεδίο 

δήλωσης παραμέτρου. Στην συνέχεια εισάγουμε ένα εύρος ισχύος εισόδου που θέλουμε να 

μελετήσουμε. 

 

 

Start -45 dBm Stop -5 dBm. Πατάμε Apply. Στην συνέχεια πάμε στο 

Display tab στο ίδιο παράθυρο και δηλώνουμε ότι θέλουμε να 

εμφανίζονται στο σχηματικό οι εξής παράμετροι:  

 

 

 

 Πατάμε ξανά Apply μετά ΟΚ !  

 

  Ενώ είμαστε στο σχηματικό, πηγαίνουμε σε κάποια Simulator 

παλέτα, (για παράδειγμα στο Simulation_AC παλέτα ) και παίρνουμε 

μία Measurement Equation. Eκεί δηλώνουμε τα εξής: 

 

 *To OutputPower περιλαμβάνει όλες τις αρμονικές 

 

 Όπως έχουμε αναφέρει θα μπορούσαμε και στο παράθυρο data_display να 

ορίσουμε την εξίσωση αυτή, ωστόσο αν θέλουμε να φτιάξουμε διαφορετικά 

παράθυρα data_display και θέλουμε να χρησιμοποιήσουμε την ίδια μεταβλητή θα 

πρέπει κάθε φορά να γράφουμε την εξίσωση. Γράφοντας την στο σχηματικό θα 

είναι πάντα διαθέσιμη.  
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Πατάμε Save_as Laboratory_4Β_Compression.dsn την σχεδίαση που έχουμε κάνει και 

ύστερα Simulation, F7. 

 

 Ο στόχος σε αυτό το σημείο είναι να κάνουμε μία γραφική του κέρδους στην 

θεμελιώδη συχνότητα {1 GHz} συνάρτηση της ισχύς εισόδου. Περιμένουμε να 

υπάρξει ένας κορεσμός για μία δεδομένη ισχύ εισόδου. 

 

 Επίσης για την κατανόηση της λειτουργίας ενίσχυσης ενός ενισχυτή θα κάνουμε μία 

γραφική της ισχύος εξόδου στην θεμελιώδη σε σχέση με την ισχύ εισόδου ( βλέπε 

Chapter 2a διαφάνειες κ.Ματακιά) 

 

 Δίνουμε έμφαση σε ποια συχνότητα θα γίνει κάθε ανάλυση, καθώς έχουμε και 

αρμονικές. Συνεπώς, πρέπει να ορίζουμε αυστηρά στο πρόγραμμα για ποια ισχύ 

εξόδου και πιο κέρδος αναφερόμαστε. 

 

 

Ενώ είμαστε στο data_display, φτιάχνουμε τις εξισώσεις: 
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Η αγγύλη [1] εννοεί ότι θέλουμε την πρώτη αρμονική του OutputPower. Στην συνέχεια 

φτιάχνουμε μία λίστα με τα παραπάνω. Το Pin δεν το βάζουμε εμείς στη λίστα αφού είναι 

αυτονόητο ότι θα μπει μόνο του εφόσον κάνουμε  Sweep σε αυτό (το αντίστοιχο συμβαίνει 

όπως έχουμε δει όταν κάνουμε σάρωση σε εύρος συχνοτήτων) 

 

 Στη συνέχεια κάνουμε plot τα γραφήματα: 
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 Αν θέλω να μεγαλώσω το εύρος τιμών του Pin, κάνω πρώτα ένα Save_as 

Laboratory_4Β_Compression.dss . Το αφήνω ανοιχτό όμως, δεν χρειάζεται να το κλείσω. 

 

 Έπειτα πάω στο σχηματικό>controller>Stop Sweep και εισάγω 5 (μέγιστη τιμή για 

Pin) 

 Kάνω Save και πατάω Simulate, F7. 

 

 To παράθυρο data_display ανανεώνεται αυτόματα έχοντας 

πάρει το καινούργιο εύρος τιμών. 

 

Εισάγουμε επίσης την εξίσωση Linear=Pin+20. Αυτό θα μας δώσει 

την έκφραση της εξόδου του ενισχυτή αν δεν παρουσίαζε κορεσμό. 

Κάνουμε διπλό κλικ στην δεύτερη γραφική>Plot Type>Equations 

και εισάγουμε την εξίσωση linear. 

 

 

 Περισσότερες πληροφορίες για το σημείο συμπίεσης θα βρείτε στις διαφάνειες του 

κ.Ματακιά/μάθημα 2ο 
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Μέρος 5. Παράγωγα ενδοδιαμόρφωσης  

 
 Εισαγωγή 
 

 Στην συνέχεια, θα μελετήσουμε τις συχνότητες που είναι παράγωγα 

ενδοδιαμόρφωσης (Intermodulation Products) στην έξοδο του ενισχυτή που 

μελετάμε, όταν στην είσοδο του εισέλθουν δύο συχνότητες (αρκετά κοντινές μεταξύ 

τους) με ίδια ισχύ.  

 

 5.1 Υπολογισμός σημείου ΤΟΙ για έναν ενισχυτή 
 

Για να δημιουργήσουμε δύο συχνότητες χρειαζόμαστε την κατάλληλη γεννήτρια να τις 

δημιουργήσει. Σβήνουμε την πηγή P_1Tone, πηγαίνουμε στην παλέτα Sources-Freq 

Domain και επιλέγουμε την πηγή P_nTone.  

 

 
 Πατάμε διπλό κλικ στην γεννήτρια και εισάγουμε και δεύτερη 

συχνότητα (0.95 GHz) πατώντας Add ενώ είμαστε στην 

επιλογή Freq[1]=1.0 GHz που εμφανίζεται στην λίστα. 

 

 Επίσης εισάγουμε και ισχύ για την δεύτερη συχνότητα με την 

ίδια διαδικασία. 

 

 

  

 

 

  Στην συνέχεια πάμε στον Simulator που υπάρχει στο σχηματικό και 

εισάγουμε και εκεί την δεύτερη συχνότητα ως 0.95 GHz που θα 

χρησιμοποιήσουμε πατώντας Add μετά Apply και ΟΚ. 

 

 

 

 

Επίσης πατώντας στον ενισχυτή διπλό κλικ, βρίσκουμε την παράμετρο ΤΟΙ  (Third Order 

Interception Point). Αυτή αναφέρεται στην  ισχύ εξόδου για τους ενισχυτές (ονομάζεται 

επίσης και IP3 ) και βάζουμε την τιμή 20. 
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   Σαν εμπειρικός κανόνας ισχύει OIP3 (dBm)~1dB.CompPoint+ 10. To σημείο συμπίεσης 

για τον ενισχυτή αυτόν ειναι 8 dBm. Eπίσης πατάμε display την παράμετρο στο σχηματικό.  

Αφαιρούμε απο τον Simulator το Sweep που είχαμε βάλει ως Pin. Δίνουμε στο Pin την τιμή 

-30 dBm. Τελικά: 

 

 

 

 

 

 

 

 

 

 

 

 

 

Πατάμε save as Laboratory_5_Intermodulation.dsn και Simulate, F7. 

 

  Στο data_display παράθυρο, δημιουργούμε μια γραφική του 

Vout σε dBm. Επίσης εισάγουμε μία λίστα και επιλέγουμε την 

εμφάνιση του Μix. O πίνακας που θα δημιουργηθεί 

περιλαμβάνει όλες τις συχνότητες της γραφικής παράστασης 

και την τάξη του κάθε προϊόντος ενδοδιαμόρφωσης.  

 

Συνεπώς με τον marker θα επιλέγουμε όποια συχνότητα θέλουμε και με τον πίνακα 

δίπλα θα βλέπουμε ποια είναι η τάξη της. 
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  To σημείο OIP3=20 dBm είναι η ισχύς εξόδου του ενισχυτή στην οποία η συχνότητα του 

βασικού τόνου (ω1 ή ω2) παίρνει την ίδια τιμή με το προϊόν τρίτης τάξης 

ενδοδιαμόρφωσης (ω1-2ω2 ή 2ω2-ω1). Βάζοντας ένα tuner στην ισχύ Pin στο σχηματικό 

και κάνοντας κάποιες δοκιμές παρατηρούμε πράγματι ότι αυξάνοντας την ισχύ εισόδου τα 

προϊόντα τρίτης τάξης μεγαλώνουν αλλά ποτέ δεν θα γίνουν ίσα με την θεμελιώδη 

συχνότητα αφού το σημείο αυτό στην ουσία είναι φανταστικό λόγω της συμπίεσης των 

συχνοτήτων στην έξοδο του ενισχυτή.  Ωστόσο μας  δίνει ένα καλό μέτρο για το πόσο 

καλός είναι ένας ενισχυτής. 

 

 

 
 

 

Eίναι πολύ σημαντικό πριν κάνουμε τις προσομοιώσεις ή τουλάχιστον παράλληλα, να 

μελετάμε την θεωρία. Είναι πολύ εύκολο να χαθεί και να μπερδευτεί κάποιος, αν δεν κάνει 

εκτίμηση των αποτελεσμάτων και αν αυτά έχουν κάποιο φυσικό νόημα. Ο σκοπός δεν 

είναι να αλλάζουμε τιμές και να βλέπουμε τις γραφικές παραστάσεις να μεταβάλλονται, 

αλλά να καταλάβουμε γιατί και πώς συμβαίνει αυτό. 

 

 Περισσότερες πληροφορίες για το σημείο ΤΟΙ θα βρείτε στις διαφάνειες του 

κ.Ματακιά/μάθημα 2ο 

 

Πατάμε save as Laboratory_5_Intermodulation.dds και κλείνουμε τα πάντα. Μόνο το 

Main_Window μένει ανοιχτό. 
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Μέρος 6. LC-Networks  

 Εισαγωγή 

 

 Στο μέρος αυτό της εργασίας θα παρουσιάσουμε πως γίνεται να φτιάξουμε 

δικτυώματα προσαρμογής στο ADS με χρήση του χάρτη Smith. Συγκεκριμένα θα 

σχεδιάσουμε ένα δικτύωμα προσαρμογής L (downward Impedance Transformer) 

 

 

 6.1 Σχεδιασμός δικτυώματος προσαρμογής με χρήση χάρτη 

Smith 
 

  Ανοίγουμε ένα καινούργιο σχηματικό. Ο στόχος μας σε αυτό σημείο είναι να δούμε πως 

μπορούμε να σχεδιάσουμε απλά δικτυώματα τύπου L στο ΑDS. Βασική προϋπόθεση 

φυσικά είναι να μπορούμε να σχεδιάζουμε στο χαρτί τουλάχιστον βασικές τοπολογίες, 

ώστε να καταλαβαίνουμε την διαδικασία που θα κάνουμε στο ADS. 

 

 Εισάγουμε δύο τερματισμούς από την παλέτα Simulation_S-Param όπως και έναν S-

Parameter Simulator. Στον τερματισμό για την πηγή έχουμε Ζ=100, ενώ για το φορτίο 

δίνουμε τιμή 200-j*100. H γραμμή μεταφοράς είναι Ζο=100 Ω και θέλω να πετύχω 

συντονισμό στα 500ΜΗz. Aυτός είναι ο στόχος μου.  

 

 

 Ρυθμίσω τον Simulator να σαρώσει συχνότητες από 0 μέχρι 

1GHz με βήμα 1MHz. 

 

 

 

 

Aποθηκεύουμε Save_as: Laboratory_6_Transformers.dsn και πατάμε προσομοίωση, F7. 

 

 Στο παράθυρο data_display πατάμε εμφάνιση της γραφικής S11 σε dB. 

  

 H προσαρμογή εισόδου δεν είναι όπως είναι προφανές καλή! 

Τα -6.9 dB αντιστοιχούν σε ~20% ανακλώμενη ισχύ.  
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 Για να βελτιώσουμε την προσαρμογή θα χρησιμοποιήσουμε ένα κύκλωμα LC. 

 

 
 

 
 Το μόνο που απομένει είναι να δούμε τι τιμές για τον πυκνωτή και το 
πηνίο θα χρησιμοποιήσουμε.  Πηγαίνουμε στις παλέτες και επιλέγουμε 
την Smith Chart Matching παλέτα. Στην συνέχεια επιλέγουμε το ένα και 

μοναδικό στοιχείο που παρέχει  και το τοποθετούμε στο σχηματικό. 
 
 
 
 
 
 
Στην συνέχεια τοποθετούμε το στοιχείο με τον χάρτη Smith ανάμεσα στην πηγή και το 
φορτίο. Στην πράξη το στοιχείο αυτό στο τέλος θα περιέχει μέσα του το κύκλωμα 
προσαρμογής. Πατάμε Save. 
 
 

 
 
 
 Aφού επιλέξουμε το στοιχείο του χάρτη Smith στο σχηματικό, και δημιουργηθεί ένα 
μαύρο τετράγωνο γύρω του, στην συνέχεια πηγαίνουμε Tools>Smith Chart.   
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Στο μήνυμα που θα σας εμφανιστεί πατήστε την πρώτη επιλογή Update SmartComponent 
form Smith Chart Utility. 
 
 Ένα καινούργιο περιβάλλον ανοίγει! Σε αυτό το περιβάλλον θα δημιουργήσουμε το πρώτο 
κύκλωμα προσαρμογής! Ειναι αρκετά απλο! 
  

 
 
 Θα αναλύσουμε λίγο το περιβάλλον και τι περιέχει: 
 
#1) Αυτό είναι το κύκλωμα μου με την πηγή και το φορτίο. Τιμές πρέπει να δηλώσω εγώ. 
Στην συνέχεια που θα δημιουργηθεί το δικτύωμα, καινούργιες διατάξεις θα προστεθούν 
στον χώρο αυτό. 
 
#2) Εδώ είναι ο χώρος που θα εμφανίζεται το γράφημα για την γραφική S11 ή 
οποιαδήποτε  άλλη παράμετρο θέλουμε να μελετήσουμε. 
 
#3) Εδώ είναι η παλέτα που είναι διαθέσιμη στην εφαρμογή. Έχει οτιδήποτε μπορεί να 
χρειαστεί για ένα κύκλωμα προσαρμογής. 
 
#4) Εδώ θα δηλώσουμε την συχνότητας λειτουργίας 500ΜHz καθώς και την Ζο=100 Ω. 
 
#5) Ο χάρτης Smith γεμάτος με επιλογές για τον συντελεστή ανάκλασης ( Gamma, < ) την 
εμπέδηση (Impedance) Z=R+jX , την αγωγιμότητα Y (Admittance) =G+jB , VSWR. 
 
 

#1 

#3 

#2 

#5 

#4 
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Στην συνέχεια:   
 

 Πηγαίνοντας στον χώρο #1 πατάμε πάνω στο κουτάκι του φορτίου και εισάγουμε 
την εμπέδηση 200-j*100. Στην συνέχεια πατάμε Lock Load Impedance. Η ίδια 
διαδικασία για το κουτάκι της πηγής με 100 Ω. 
 

 Στον χώρο #2 γράφουμε σαν Stop Frequency 1e9 και ως Type , dB. 
  

 Στον χώρο #4, βάζουμε συχνότητα λειτουργίας 0.5 GHz και Ζο=100 Ω και πατάμε 
Normalize 

 
 
 
Πατώντας στο κουτάκι του φορτίου παίρνουμε πληροφορίες για το συντελεστή ανάκλαση 
Gamma=0.44 (αναφέρεται σε σχέση τάσης, που αντιστοιχεί σε 20% ανακλώμενη ισχύς). 
 
 

 
 
 
 
  
  Στην συνέχεια από την παλέτα διαλέγουμε ένα 
πυκνωτή παράλληλα με το φορτίο μας (shunt 
capacitor).Ταυτόχρονα πηγαίνουμε τον κέρσορα 
στον χάρτη Smith και παρατηρούμε ότι η θέση μας 
πάνω στο χάρτη μπορεί να μετακινηθεί!  
 
Από το σημείο που ήμασταν (που αντιστοιχεί στην 
θέση του φορτίου) μπορούμε να μετακινηθούμε! 
Μετακινούμε την θέση μας με φορά του ρολογιού και 
σταματάμε στο κύκλο με κανονικοποιημένη 
αντίσταση, 1. Αυτός είναι και ο πρώτος στόχος μας: 
να προσαρμόσουμε το πραγματικό μέρος της πηγής 
με του φορτίου.  
 
Συνεπώς τώρα βρισκόμαστε σε ένα σημείο με κανονικοποιημένη εμπέδηση  z~1-j*1.24 Ω 
μπορεί να μην έχετε ακριβώς αυτές τις τιμές, αλλά κοντινές. Δεν υπάρχει πρόβλημα σε 
αυτό. 
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 To μόνο που μένει ώστε να ολοκληρωθεί η προσαρμογή είναι να 
ακυρώσουμε το φανταστικό μέρος  -1.24. Για να το κάνουμε αυτό 
θα πρέπει να χρησιμοποιήσουμε ένα πηνίο. Κοιτώντας στον χώρο 
#1 έχει δημιουργεί το μισό δικτύωμα. 
 
 
 
 
 
 
  Επιλέγοντας από την παλέτα ένα πηνίο σε σειρά (Inductor Series), πηγαίνοντας στον 
χάρτη συνεχίζουμε από εκεί που είμαστε, και τραβάμε τον κέρσορα ώστε να βρεθούμε στο 
κέντρο του χάρτη για να έχουμε τέλεια προσαρμογή. Τελικά έχουμε κάτι τέτοιο: 
 
 

 
 
 
 Πατώντας πάνω στο σχηματικό στον χώρο #1, στον πυκνωτή και στο πηνίο βλέπουμε 
τιμές τους για την προσαρμογή αυτή.  
 

 Πυκνωτής: 0.89 pF ή 896 fF 
 Πηνίο: 38 nH  
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 Έπειτα πατάμε  
 
 Εμφανίζεται το σχηματικό. Το εικονίδιο του χάρτη Smith περιέχει πολλές πληροφορίες. 
 

 
 
 
 Πατάμε στο εικονίδιο του χάρτη Smith και έπειτα το (Pop In) 
 
 Όπως είναι αναμενόμενο εμφανίζεται το κύκλωμα που μόλις φτιάξουμε. 
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 Επιστρέφουμε στο σχηματικό (Pop Out) . Eπίσης πατάμε Close στο παράθυρο που 
χτίσαμε το κύκλωμα προσαρμογής (Smith Chart Utility). 
 
 
 Ενώ είμαστε στο σχηματικό πατάμε Simulate, F7 για να δούμε την εμφάνιση της γραφικής 
S11 σε dB. 
 Πράγματι ο συντελεστής ανάκλασης είναι βελτιωμένος και έχουμε πολύ καλή 
προσαρμογή. 
 
 

 
 
 

Αποθηκεύουμε το data_display παράθυρο και στην συνέχεια το κλείνουμε όπως και το 
σχηματικό. Μόνο το Main_Window μένει ανοιχτό. 
 
 Συγχαρητήρια σχεδιάσατε το πρώτο κύκλωμα προσαρμογής στο ADS ! 
 
 

 Περισσότερες πληροφορίες για τα δικτυώματα προσαρμογής και τον χάρτη Smith 
θα βρείτε στις διαφάνειες του κ.Ματακιά/μάθημα 10ο και 11ο) 
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Μέρος 7. Optimization and Goals 

 
 Εισαγωγή 
    

 Στο μέρος αυτό της εργασίας θα αντιμετωπίσουμε ένα πρόβλημα προσαρμογής που 

εμφανίζεται στις θύρες εισόδου και εξόδου ενός ενισχυτή με την χρήση κατάλληλων 

δικτυωμάτων προσαρμογής. Επίσης θα δείξουμε μια μέθοδο εύρεσης των βέλτιστων 

τιμών για τα δικτυώματα προσαρμογής χωρίς να χρειάζεται να χρησιμοποιήσουμε 

τον χάρτη Smith. 

7.1 Bελτιστοποίηση τιμών και εισαγωγή στόχων στο 

σχηματικό 
 

Ανοίγουμε από το Main_Window το Laboratory_4A_Harmonics.dsn. Η εικόνα που έχουμε 

είναι η παρακάτω.  

 

 
 
     Στην συνέχεια κάνουμε Save_as Laboratory_7_OptimumAmp.dsn για να 

δημιουργήσουμε ένα νέο σχηματικό που θα εργαστούμε. Βρίσκουμε το εικονίδιο 

Deativate or Activate_Components το πατάμε και στη συνέχεια κάνουμε κλικ πάνω στον 

Harmonic_Balance Simulator. Θα εμφανιστεί ένα κόκκινο Χ σημαίνοντας ότι είναι 

απενεργοποιημένος. Έπειτα εισάγουμε ένα S-Parameters Simulator και τον τοποθετούμε 

στο σχηματικό. Η εικόνα που έχουμε είναι η εξής: 
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   Επειδή θα κάνουμε ανάλυση των S-Parameters είναι πολύ σημαντικό να είναι δηλωμένες 

με την σωστή αρίθμηση: η θύρα εισόδου ,Num=1 για την γεννήτρια, και Num=2 για τον 

τερματισμό. Αφού ελέγξουμε πατάμε Simulate, F7. Το γεγονός ότι για πηγή έχουμε το 

P_1Tone αντί για ένα Term1, δεν δημιουργεί κάποιο πρόβλημα. Και με τους δύο τρόπους 

μπορεί να γίνει ανάλυση S-Parameters.  

 

   Στο data_display παράθυρο δημιουργούμε γραφικές για το S11 και S21. Παρατηρούμε ότι 

το S11 παίρνει ιδανική τιμή (πολύ μεγάλο νούμερο) συνεπώς τέλεια προσαρμογή, ενώ το 

S21 έχει τη τιμή ενίσχυσης που δώσαμε στο ενισχυτή. 

 

 
 

   Επιστρέφουμε στο σχηματικό και κάνουμε 

διπλό-κλικ στο εικονίδιο του ενισχυτή. 

Δηλώνουμε όπου Z1=300 Ohm και όπου 

Z2=25 Ohm και display. 

 

 

 Στη συνέχει πατάμε ξανά Simulation, F7 και παρατηρούμε: 
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    Ουσιαστικά αυτό που κάναμε είναι ότι δηλώσαμε ρεαλιστικές τιμές για την αντίσταση 

εισόδου και εξόδου του ενισχυτή. Αυτές οι τιμές είναι διαφορετικές από τις τιμές της πηγής 

και αντίστοιχα του φορτίου που είναι συνδεδεμένος ο ενισχυτής με αποτέλεσμα:  

« κακή προσαρμογή ».  

 

   Για να λυθεί το πρόβλημα αυτό μπορούμε να βάλουμε κάποια δικτυώματα προσαρμογής 

όπως κάναμε προηγουμένως (Μέρος 6.). Θα χρησιμοποιήσουμε πηνία και πυκνωτές σε 

κατάλληλη τοπολογία.  

 

   Ένας τρόπος είναι να ανοίξουμε ένα παράθυρο με τον χάρτη Smith, όπως κάναμε 

προηγουμένως (δηλώνουμε αντίσταση φορτίου και πηγής και βρίσκουμε τις κατάλληλες 

τιμές για τα πηνία και τους πυκνωτές). Επειδή αυτή η τεχνική είναι κάποιες φορές 

χρονοβόρα μπορούμε να χρησιμοποιήσουμε την μέθοδο της βελτιστοποίησης 

"Optimization", βάζοντας κάποιους στόχους,"Goals",στον προσομοιωτή που 

χρησιμοποιούμε.   

 

     Για αρχή τοποθετούμε δικτυώματα εισόδου και εξόδου όπως παρακάτω. Επίσης 

δίνουμε ονόματα match_in/out. Αφήνουμε τις default τιμές τους. 

 

 
 

  Κάνουμε Save το σχέδιο μας. 

 

    Έπειτα πηγαίνουμε στις παλέτες και εισάγουμε απο την Optim/Stat/Yield/Doe παλέτα 

 έναν Οptimization Controller και ένα Goal. 
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  Πατάμε διπλό-κλικ στο Goal και εισάγουμε: 

 

 Expr: dB(S(1,1)) 

 SimInstanceName: SP1 

 Max: -30 

 Range Var: freq 

 Range Min: 0.95 GHz 

 Range Max: 1.05 GHz 

 

 

 Oυσιαστικά ζητάμε την βελτιστοποίηση αυτής της παραμέτρου σε ένα συγκεκριμένο 

ευρος τιμών και με μέγιστη τιμή τα -30dB. 

 

 Θέλουμε να βάλουμε τον ίδιο στόχο και για την παράμετρο S21. Βρίσκουμε το διπλανό 

εικονίδιο, το πατάμε και στη συνέχεια πατάμε μονό-κλικ το Goal που έχουμε ήδη στο 

σχηματικό με στόχο να δημιουργήσουμε ένα δεύτερο Goal. Αλλάζουμε όπου 

dB(S(2,1)) και Min 19.5 και Μax 20. 

 

 Επίσης στις παραμέτρους του Optim Controller βρίσκουμε το MaxIter=125 (ή διπλό-

κλικ/Setup/OptGoal/Number of Iritations) και FinalAnalysis="SP1" (ή διπλό-

κλικ/Parameters/Final Analysis) . Όλα τις άλλες επιλογές δεν τις πειράζουμε. 
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Στην συνέχεια πατάμε διπλό-κλικ στο 

Lmatch_input>Tune/Opt/Stat/DOESetup>Optimization>Enable 

 

 Δηλώνουμε εύρος τιμών από 1 μέχρι 30   nH.   

 

 Κάνουμε ακριβώς την ίδια διαδικασία για το πηνίο 

Lmatch_output. 

 

 Για τους πυκνωτές εισόδου και εξόδου δίνουμε ως εύρος 

τιμών 0.1 με 5 pF.  

 

 

Mην ξεχνάτε να πατάμε Apply και μετά ΟΚ σε όλες τις διαδικασίες καταχώρησης 

δεδομένων. 

 

Πατάμε Simulation, F7. 

 

 Στο παράθυρο data_display εισάγουμε πλέον τις γραφικές: 

 dB FinalAnalysis1.SP1.SP.S(1,1) 

 dB FinalAnalysis1.SP1.SP.S(2,1) 

 

 
 

 Όπως φαίνεται επιτύχαμε τους στόχους μας! Η προσαρμογή εισόδου και η ενίσχυση είναι 

σωστές! Για να βρούμε τις βελτιστοποιημένες τιμές πηνίων και πυκνωτών  πηγαίνουμε 

στο σχηματικό Simulate>Update Optimization Values. 

 

  Απενεργοποιούμαι τον Optimization Controller και τα δύο Goals αν δεν χρειάζεται να 

κάνουμε παραπέρα ανάλυση ! Επίσης πηγαίνουμε σε κάθε στοιχείο που βελτιστοποιήσαμε 

και πατάμε το Clear στην επιλογή Optimization Status. 
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Μέρος 8. Transistor 

Εισαγωγή 

 

 Στο μέρος αυτό της εργασίας θα σχεδιάσουμε ένα BJT, αφού πρώτα 

συμπεριλάβουμε τα παρασιτικά στοιχεία που εμφανίζονται μεταξύ των 

ακροδεκτών του. Στην συνέχεια θα κάνουμε DC ανάλυση και θα κατασκευάσουμε 

ένα δικτύωμα πόλωσης. Θα εισάγουμε κυκλώματα προσαρμογής εισόδου-εξόδου 

καθώς και οτιδήποτε άλλο χρειαστεί ώστε το κύκλωμα να λειτουργεί ως ενισχυτής 

με συχνότητα λειτουργίας τα 1.9 GHz. Στο τέλος θα παρουσιαστεί η εξάρτηση των 

χαρακτηριστικών του ενισχυτή από την μεταβολή της τροφοδοσίας του.  

 

8.1 Δημιουργία-εισαγωγή μοντέλου BJT 
 

Ανοίγουμε ένα νέο σχηματικό, και πηγαίνουμε στις παλέτες Devices BJT.   

Aπό εκεί επιλέγουμε τα: BJT_NPN και το BJT_Model5 στοιχεία. 

 

Παρατηρούμε ότι το στοιχείο BJT_NPN, στα χαρακτηριστικά 

του γράφει ως: Model=BJTM1. Το μοντέλο που έχουμε 

εισάγει με την πληθώρα πληροφοριών όπως φαίνεται στην 

εικόνα δίπλα, περιέχει πολλές παραμέτρους. Θα δηλώσουμε 

τις τιμές που θέλουμε στις παραμέτρους και αυτές αυτόματα 

θα φορτωθούν στο τρανζίστορ που έχουμε επιλέξει 

(BJT_NPN). 

 

 

Ι. Στην συνέχεια πατάμε διπλό-κλικ στο BJT_Model, πηγαίνουμε Component 

Options/Parameter Visibility/Clear all και πατάμε ΟΚ. Μένοντας στο ίδιο παράθυρο, 

εισάγουμε τιμές σε κάποιες παραμέτρους: Bf=beta (DC current-gain, στην συνέχεια 

θα το μεταβάλλουμε όπως θέλουμε), Vaf=50 (Early Voltage) και Ιse=0.02e-12 (Base-

Emitter leakage Saturation Current) και στο καθένα από αυτά πατάμε Display 

parameter on Schematic. 

 

 

 

ΙΙ. Πατάμε στο BJT_NPN, και δηλώνουμε ότι μόνο η παράμετρος Model=BJTM1 

θέλουμε να εμφανίζεται στο σχηματικό. 

 

                                                        
5 Το συγκεκριμένο μοντέλο για την ανάλυση του BJT ονομάζεται Gummel-Poon Model 
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8.2 Εισαγωγή παρασιτικών στοιχείων 
 

 

  Ξεκινώντας πηγαίνουμε στην παλέτα Lumped-Components και εισάγουμε, 3 πηνία (320 

pH) και 2 πυκνωτές (120 fF). Η τοπολογία που θα ακολουθήσουμε φαίνεται στο 

παρακάτω κύκλωμα. Στο πηνίο που συνδέεται με την βάση, βάζουμε αντίσταση 0.01 Ohm. 

Τοποθετούμε θύρες στους τρείς ακροδέκτες του κυκλώματος με την αρίθμηση που 

φαίνεται παρακάτω. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 Είμαστε έτοιμοι να δημιουργήσουμε ένα σύμβολο, όπως κάναμε στο Laboratory_3B_RLC. 

Ωστόσο αυτή τη φορά δεν θα χρειαστεί να δημιουργήσουμε ένα δίθυρο, αλλά θα 

κρατήσουμε την τοπολογία του τρανζίστορ με 3 - ακροδέκτες.  

 Αποθηκεύουμε το σχηματικό που δημιουργήσαμε Laboratory_9A_Transistor. 

 

   Για να δημιουργήσουμε σύμβολο πηγαίνουμε: 

 

 View>Create/Edit Schematic Symbol. Ένα νέο παράθυρο ανοίγει. Πατάμε ΟΚ και 

δημιουργείται ένα κουτί με τρείς θύρες. Επειδή δεν θα χρησιμοποιήσουμε το κουτί 

αυτό θα το διαγράψουμε πηγαίνοντας: Select>Select all και πατάμε το Delete.  

 

 Πατάμε ξανά View>Create/Edit Schematic Symbol και επιστρέφουμε στο 

σχηματικό. 
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 Πατάμε Save και έπειτα πάμε File> Design Parameters  

 

 Στο Component Instance Name γράφουμε: Q 

 

 Στο Symbol Name: SYM_BJT_NPN 

 

 Artwork>Type: Fixed και Name: SOT236 

 

 To Description είναι το πεδίο που δηλώνουμε 

το όνομα του συμβόλου, πως θα εμφανίζεται 

στην βιβλιοθήκη.  

Δίνουμε για όνομα: transistor_package 

 

 

 

Έπειτα πατάμε, Save AEL file και στην συνέχεια πηγαίνουμε στο Parameters tab. 

 

 

Θα δηλώσουμε την παράμετρο beta, ώστε να 

εμφανίζεται στο σχηματικό κάτω από το 

σύμβολο που δημιουργήσαμε, Q. 

  

 Δηλώνουμε : 

-Parameter Name: beta 

-Defaul Value: 100  

 

 

 Και έπειτα πατάμε add και ΟΚ. 

 

 

 

Επιστρέφουμε στο σχηματικό και κάνουμε Save. 

 

 

 

 

 

                                                        
6 SOT-23, σημαίνει "Small Outline Transistor". Aναφέρεται σε SMD τραζίστορ. Το 23, υποδηλώνει το 
configuration του package που συγκεκριμένα είναι πλαστικό και όχι μεταλλικό. 
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8.3 Mελέτη της χαρακτηριστικής καμπύλης συλλέκτη, Ic - Vce 
 

 

 Για τις προδιαγραφές του ενισχυτή (common-emitter) που θα δημιουργήσουμε, θέτουμε 

ως επιθυμητό σημείο λειτουργιάς, Q του τρανζίστορ το σημείο όπου: VCE=3 Volt και IC=3.3 

mA. Ο συντελεστής απολαβής DC ρεύματος, β (beta) έχει την τιμή, 160. Η τροφοδοσία του 

κυκλώματος θα είναι VCC=5 Volt. Η συχνότητα λειτουργίας είναι 1.9 GHz. 

 

 Για την μελέτη των χαρακτηριστικών καμπύλων χρησιμοποιούμε όργανα μέτρησης που 

ονομάζονται Curve Tracers. Μία εικόνα ενός τέτοιου μηχανήματος φαίνεται παρακάτω: 

 

 
 

Ενώ βρισκόμαστε στο σχηματικό πηγαίνουμε File>Νew Design. Δηλώνουμε για όνομα του 

νέου σχηματικού που θα δημιουργήσουμε Laboratory_9_Curve_Tracer και όπου λέει 

Schematic Design Template, δηλώνουμε BJT_curve_tracer. Υπάρχει φυσικά η επιλογή και 

για FET, αν είχαμε χρησιμοποιήσει τέτοιο είδος τρανζίστορ. Αν θέλαμε να ανοίξουμε 

καινούργιο σχηματικό, κενό, θα αφήναμε το πεδίο στο "None". 

 

 

 

 

 

 

 

 

 

 

 

 

 

Ανοίγει ένα νέο σχηματικό. 
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  Όπως θα παρατηρήσετε υπάρχουν δύο προσομοιωτές. Ό ένας είναι ο DC που κάνει μία 

σάρωση της τάσης VCE και ο άλλος, Parameter Sweep σαρώνει το ρεύμα βάσης IBB και έχει 

ταυτόχρονα ως είσοδο (SimInstanceName[1]) και τον DC προσομοιωτή. Χρησιμοποιείται 

όταν έχουμε πάνω από έναν προσομοιωτή στο σχηματικό για να τους συντονίσει όλους 

μαζί. 

 

  Έπειτα πηγαίνω στην βιβλιοθήκη, Projects>lab_2011117 και επιλέγω το στοιχείο με την 

περιγραφή που δώσαμε στην δημιουργία του συμβόλου. Τοποθετούμε το τρανζίστορ στο 

σχηματικό. Υπενθυμίζω ότι πατώντας το πλήκτρο F5 και επιλέγοντας ένα στοιχείο μπορώ 

να μετακινήσω την ταμπέλα με τις πληροφορίες του. Αλλάζουμε απευθείας από το 

σχηματικό την τιμή του beta σε 160 και κάνουμε τις συνδεσμολογίες με το curve_tracer. 
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Πατάμε Save και μετά Simulate, F7 και παίρνουμε τις χαρακτηριστικές καμπύλες: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 Από την ανάλυση που έκανα καταλαβαίνω ότι: όταν ρέει την διάταξη μου ρεύμα βάσης 

ΙΒΒ=40 μΑ, και αναπτύσσεται τάση VCE=3 V, τότε στον συλλέκτη έχω ρεύμα ΙC=3.3 mA.  

Επίσης στον πίνακα παραπάνω αναγράφεται η ισχύς που καταναλώνεται στο τρανζίστορ. 

Η ισχύς υπολογίζεται ως: P=ΙC*VCE και δεν πρέπει να υπερβαίνει την τιμή που δίνει ο 

κατασκευαστής για κάθε τρανζίστορ ώστε να μην καταστραφεί. Επίσης θα βοηθήσει πολύ 

την μελέτη μας να γνωρίζουμε την τιμή της τάσης VBE στο σημείο ισορροπίας. Για να το 

βρω βάζω Pin Label στο σημείο που βρίσκεται η βάση και φτιάχνω μία λίστα στο 

data_display . Η τιμή τάσης πρέπει να είναι: VBE=798.8 mV. 

 

8.4 Δημιουργία κυκλώματος πόλωσης 
 

 Αφού μελετήσαμε το σημείο λειτουργίας του transistor, θα πρέπει να επιλέξουμε ένα 

δικτύωμα πόλωσης (Biasing) ώστε να εξασφαλίσουμε την ορθή λειτουργίας του 

κυκλώματος στην ενεργό περιοχή. Τα πιο δημοφιλή δικτυώματα πόλωσης είναι τα εξής: 

 

 

 Base (or Fixed) Bias 

 

 Collector-feedback Bias 

 

 Emitter Bias 

 

 Voltage divider Bias 

Format> 

Significant  Digits: 4 
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  Φυσικά το καθένα από αυτά έχει τα πλεονεκτήματα και τα μειονεκτήματα του και 

χρησιμοποιείται σε συγκεκριμένες εφαρμογές. Εμείς θα επιλέξουμε το δικτύωμα του 

Collector-feedback. Χρησιμοποιείται σε περιπτώσεις που για διάφορους λόγους (πχ. 

μεταβολή της θερμοκρασίας) μεταβάλλεται το β του τρανζίστορ. Αυτό έχει ως αποτέλεσμα 

να μεταβάλλεται το ρεύμα του συλλέκτη με αποτέλεσμα τον μεγάλο κίνδυνο ζημίας ή 

προβληματικής λειτουργίας του τρανζίστορ.  

 

 Το κύκλωμα αυτό προσφέρει ένα μηχανισμό ανατροφοδότησης κρατώντας το ρεύμα του 

συλλέκτη σχεδόν σταθερό,  με την μεταβολή του β.  

 

 

Με βάση το κύκλωμα δίπλα και έχοντας ως δεδομένο τις τιμές για το 

VCC=5 V, IB=40 μΑ, IC=3.3 mA, VBE=798.8 mV και VCE=3 V, υπολογίζουμε 

τις τιμές για τις αντιστάσεις: 

 

 RB=
     

  
 55.030 Ω ~55 KΩ 

 

 RC=
      

  
=606 Ω 

 

 

 

Eίμαστε έτοιμοι να προσομοιώσουμε το κύκλωμα που σχεδιάσαμε. Δημιουργούμε νέο 

σχηματικό με ονομασία Laboratory_9B_transistor.dsn και κλείνουμε το παλιό. 

Φτιάχνουμε το παρακάτω κύκλωμα: 

 

Για να προσομοιώσουμε το κύκλωμα αυτό 

χρειαζόμαστε μόνο τον DC προσομοιωτή. 

 

Επίσης για να μην δημιουργηθεί το παράθυρο 

data_display πηγαίνουμε Simulate>Simulate Setup/ 

και όπου γράφει "Open data display when 

simulation completes " το αφήνουμε κενό και 

πατάμε Simulate. 

 

Έπειτα: Simulate> Annotate DC solution και 

ελέγχουμε τις τιμές που εμφανίστηκαν. 

 

Για να εξαφανιστούν οι τιμές πηγαίνουμε:  

Simulate> Clear DC Annotation 
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8.5 Έλεγχος - Βελτιστοποίηση λειτουργίας ενισχυτή 
 

 Πριν προχωρήσουμε στην εισαγωγή πηγής AC στο κύκλωμα που έχουμε σχεδιάσει είναι 

απαραίτητο να εισάγουμε κάποια στοιχεία ακόμα. Δημιουργούμε ένα νέο σχηματικό με 

ονομασία Laboratory_9C_transistor.dsn. Eισάγουμε 2 πυκνωτές 10 pF & 2 πηνία 120 nH 

όπως φαίνεται στο παρακάτω σχήμα.  

 

 Οι πυκνωτές αυτοί ονομάζονται σύζευξης (Coupling / DC blocking Capacitors) και 

χρησιμεύουν για την διατήρηση της πόλωσης του κυκλώματος χωρίς να επηρεαστεί από 

την πηγή του σήματος εισόδου, καθώς και για άλλους σκοπούς. Τα πηνία αυτά 

ονομάζονται τσοκ (RF Chokes) και προστατεύουν την τροφοδοσία (VCC) του κυκλώματος 

από την παρεμβολή AC σημάτων.   

 

Αφού εισάγουμε επίσης δύο τερματισμούς και έναν S-Parameter Simulator, τελικά το 

σχηματικό είναι κάπως έτσι: 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 Παρατηρούμε το στοιχείο της τροφοδοσίας έχει απομονωθεί άνω-δεξιά. Για να 

δημιουργήσουμε την τοπολογία αυτή το μόνο που χρειάζεται είναι να εισάγουμε Pin labels 

στους ακροδέκτες όπως φαίνεται στο σχήμα.  

 

Υπενθυμίζω ότι η συχνότητα λειτουργίας είναι τα 1.9 GHz. Πατάω Save και Simulate, F7 

πηγαίνουμε στο data_display και το αποθηκεύουμε. 
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Δημιουργούμε τα γραφήματα για όλες τις S-Parameters. Επίσης ανοίγουμε ένα χάρτη 

Smith και εισάγουμε τα γραφήματα S11 και S22 για να μελετήσουμε την προσαρμογή 

εισόδου και εξόδου. Το πλεονέκτημα με την χρήση του χάρτη Smith είναι ότι μπορούμε να 

δούμε την τιμή της εμπέδησης εισόδου & εξόδου του κυκλώματος. Με βάση αυτό 

μπορούμε να δημιουργήσουμε τα κατάλληλα δικτυώματα προσαρμογής.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Πράγματι η προσαρμογή στο κύκλωμα μας δεν είναι καλή. Η ενίσχυση είναι ~20 dB, αλλά 

έχει προοπτικές για μία καλύτερη τιμή. Γνωρίζοντας την εμπέδηση εισόδου και εξόδου του 

ενισχυτή φτιάχνουμε τα κατάλληλα δικτυώματα προσαρμογής (LC - Networks) και 

κάνουμε βελτιστοποίηση Eπιστρέφουμε στο σχηματικό και κατασκευάζουμε το παρακάτω 

κύκλωμα. Το αποθηκεύουμε ως Laboratory_9D_transistor.dsn.   

Format> 

Zo: 50 
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Οι στόχοι μας αυτή τη φορά είναι προσαρμογή με μέγιστη τιμή τα -15 dB. Το εύρος τιμών 

που εισάγουμε στους πυκνωτές προσαρμογής είναι {0.01 - 1 pF}, ενώ για τα πηνία {1 - 40 

nH}7. Πατάμε Simulate, F7 πηγαίνουμε στο data_display και το αποθηκεύουμε.  

 

 
 

 

 Παρατηρούμε ότι η προσαρμογή εισόδου και εξόδου βελτιώθηκε αρκετά όπως και 

το κέρδος του ενισχυτή πλέον είναι ~35 dB ενώ πριν βάλουμε τα δικτυώματα 

προσαρμογής ήταν 20 dB.  

 

   

 

                                                        
7 Για να εμφανίζεται στο σχηματικό το εύρων τιμών βελτιστοποίησης του κάθε στοιχείου  
πχ. C=1pF opt{0.01 pF to 1 pF}, πηγαίνουμε: Οptions>Preferences>Component>Text/Wire 
Label>Display>Opt>Full 



Εθνικό και Καποδιστριακό 

Πανεπιστήμιο Αθηνών 

                         Σχεδίαση VLSI κυκλωμάτων για τηλεπικοινωνιακές εφαρμογές                       (2014-15) 

 

 

75 

8.6 Εξάρτηση των S-Parameters, 1dB.C.Point από την 

μεταβολή της τροφοδοσίας VCC  
 

Mέρος 1ο: Eπιστρέφουμε στο σχηματικό και ανανεώνουμε τις βελτιστοποιημένες τιμές. 

Απενεργοποιούμε τον Optim. Controller και τα Goals όπως επίσης και τις ενδείξεις 

βελτιστοποίησης σε κάθε στοιχείο. To σχηματικό μας αποτελείται από ένα 

βελτιστοποιημένο κύκλωμα. Το αποθηκεύουμε ως Laboratory_9Ε_transistor.dsn.   

 

  Στην συνέχεια δημιουργούμε μία μεταβλητή με όνομα VCC. Δηλώνουμε με το όνομα αυτό 

την τροφοδοσία του κυκλώματος. Θα δοκιμάσουμε δύο τιμές για την τροφοδοσία (2 V και 

5 V) για να δούμε ποια θα είναι η απόκριση των S-parameters. Εισάγουμε από 

οποιαδήποτε παλέτα προσομοίωσης ένα Parameter Sweep. Πατάμε διπλό-κλικ, και στο tab 

"Sweep" δηλώνουμε Parameter to Sweep: VCC από 2 μέχρι 5 με βήμα 3. Στο tab Simulations 

εισάγουμε όπου γράφει Simulation 1: SP1 (είναι το όνομα του προσομοιωτή των S-

Parameters που χρησιμοποιούμε). 

 

 
 

Πατάμε Simulate, F7. Στο data_display παράθυρο δημιουργούμε τις γραφικές S11 και S21. 
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Από τα αποτελέσματα μπορούμε να καταλάβουμε πόσο πολύ μπορεί να επηρεαστεί το 

κύκλωμα από την τροφοδοσία του VCC.  

 

Μέρος 2ο: Όπως είδαμε στην παράγραφο 4.2 θα κάνουμε μία σάρωση με 

διάφορα επίπεδα ισχύος για να βρούμε το 1dB.Comp.Point του ενισχυτή. 

Εισάγουμε για γεννήτρια P_1Tone στην συχνότητα 1.9 GHz και δηλώνουμε 

μεταβλητή ισχύs "Pin". Έπειτα εισάγουμε ένα Harmonic Balance Simulator 

και κάνουμε Sweep την μεταβλητή Pin από {-40 μέχρι -20 dBm}. Κάνουμε 

προσομοίωση για δύο τιμές τροφοδοσίας VCC. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 Ενδιαφέρων μελέτη είναι αν βάλετε ένα tuner στην μεταβλητή VCC στο σχηματικό 

και παρατηρείτε ταυτόχρονα πως μεταβάλλονται οι S-Parameters και αντίστοιχα 

το 1dB.Comp.Point στο data_display (δεν χρειάζεται η χρήση του Parameter 

Sweep). 
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